Solaris™ Common Desktop Environment: Motif Transition Guide
Contents

Preface. ................................................................. xv

1. Moving to Motif and CDE. ................................. 1
   Summary of Motif Toolkits. ................................. 1
   Moving to Motif. ............................................... 2
     Running Existing Motif Applications on the OpenWindows Desktop ................................... 2
     Developing Solaris Motif Applications for the OpenWindows Desktop .............................. 2
   Moving to Solaris CDE ...................................... 3
     Running Existing Applications on the Solaris CDE Desktop ............................................. 3
     Porting OpenWindows Applications to the Solaris CDE Desktop ...................................... 4
     Porting Motif Applications to the Solaris CDE Desktop .................................................. 4
     Developing and Debugging Applications for the Solaris CDE Desktop ................................ 4

2. Motif Environment ........................................... 7
   Motif Packaging in the Solaris Software ............... 7
Features Only in the Solaris Motif User Interface 28
Notable Implementation Differences Between Toolkits 29
XView Libraries Versus Solaris Motif Libraries 31
Terminology 31
OPEN LOOK Versus Motif Toolkit Architecture 32
Programming Model 32
Differences Between XView and Solaris Motif 34
X Resources 35
External Files 35
OLIT Libraries Versus Solaris Motif Libraries 35
Routines Only in OLIT Library 35
Routines Only in Solaris Motif Libraries 36
Widgets 36

6. Porting Issues and Ideas 41
Elements of Migrating 42
Do You Need to Port? 42
Basic Integration 42
If You Decide to Port 43
Benefits of Porting 43
Integrating into the Solaris CDE Environment 44
Start Small 45
Convert and Clean Up 45
Use a Motif GUI Builder 45
Architectural Impact 46
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locale Announcement</td>
<td>71</td>
</tr>
<tr>
<td>Character Strings and XmStrings</td>
<td>71</td>
</tr>
<tr>
<td>To Convert from Character String to XmString</td>
<td>71</td>
</tr>
<tr>
<td>To Convert from XmString to Character String</td>
<td>71</td>
</tr>
<tr>
<td>Include app-defaults File</td>
<td>71</td>
</tr>
<tr>
<td>Localize Motif Resources</td>
<td>72</td>
</tr>
<tr>
<td>Deliver Message Catalog</td>
<td>72</td>
</tr>
<tr>
<td>CDE and gencat</td>
<td>72</td>
</tr>
<tr>
<td>.msg Files</td>
<td>72</td>
</tr>
<tr>
<td>.cat Files</td>
<td>73</td>
</tr>
<tr>
<td>Fonts</td>
<td>73</td>
</tr>
<tr>
<td>Internationalizing Shell Scripts</td>
<td>73</td>
</tr>
<tr>
<td>C. Recommended Reading</td>
<td>75</td>
</tr>
<tr>
<td>CDE Documentation</td>
<td>76</td>
</tr>
<tr>
<td>Development Environment</td>
<td>76</td>
</tr>
<tr>
<td>Run-time Environment</td>
<td>76</td>
</tr>
<tr>
<td>ToolTalk Documentation</td>
<td>76</td>
</tr>
<tr>
<td>Motif 1.2 Documentation</td>
<td>77</td>
</tr>
<tr>
<td>Graphical User Interfaces</td>
<td>78</td>
</tr>
<tr>
<td>Motif Programming</td>
<td>79</td>
</tr>
<tr>
<td>OPEN LOOK Programming</td>
<td>79</td>
</tr>
<tr>
<td>Xt/XLib Programming</td>
<td>79</td>
</tr>
<tr>
<td>Index</td>
<td>81</td>
</tr>
</tbody>
</table>
## Figures

<table>
<thead>
<tr>
<th>Figure 7-1</th>
<th>OpenWindows 3.4 Snapshot Application GUI</th>
<th>56</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 7-2</td>
<td>Motif Port of Snapshot GUI (Direct Translation)</td>
<td>57</td>
</tr>
<tr>
<td>Figure 7-3</td>
<td>Motif Port of Snapshot GUI (Final Port)</td>
<td>59</td>
</tr>
</tbody>
</table>
Tables

Table 3-1  CDE Control Widgets  ...........................................  12
Table 5-1  OPEN LOOK Mouse Buttons  ...............................  30
Table 5-2  Motif Mouse Buttons.  .......................................  30
Table 5-3  Basic Mapping of Common Objects. .......................  33
Table 5-4  Common Widget Mapping  .................................  37
Table 6-1  OLIT and Motif Geometry Manager Widgets ..........  47
Table A-1  User Interaction Changes  ...............................  61
Preface

Solaris Common Desktop Environment: Motif Transition Guide addresses:

• Issues of concern to Sun Motif® developers

• How to run existing OPEN LOOK® and Motif applications on the OpenWindows™ 3.6 and Solaris Common Desktop Environment (CDE) 1.2 desktops

• Porting OPEN LOOK and Motif applications to the Solaris CDE environment

This manual assumes you are familiar with OPEN LOOK or Motif programming. Use it in conjunction with Motif and OPEN LOOK manuals to enable your application to run on the latest Sun desktops.

Note – This book generically uses the terminology Solaris Motif for the Motif toolkit that is included with either the Solaris CDE unbundled software or the Solaris software.

Who Should Use This Book

Read Solaris Common Desktop Environment: Motif Transition Guide if you are:

• A Motif programmer interested in developing Solaris Motif applications for the OpenWindows 3.6 or Solaris CDE 1.2 desktop
• An OPEN LOOK or Motif programmer, and you want your existing applications to run on the OpenWindows 3.6 or Solaris CDE 1.2 desktop with little or no code modification

• Interested in porting your OPEN LOOK or Motif application to the Solaris CDE 1.2 desktop

This manual assumes that you are proficient in OPEN LOOK (XView™ or OLIT) or Motif application development on UNIX® platforms. If you are an OPEN LOOK developer, it assumes you are familiar with Motif, as well.

Before You Read This Book

If you are considering porting your application to the Solaris CDE 1.2 desktop, and you are not familiar with CDE, you should first read:

• Common Desktop Environment: Programmer’s Overview

  Common Desktop Environment: Programmer’s Overview provides a high level view of the CDE development environment components. It also includes an architectural overview of the entire CDE system, including both the run-time (end user) and development environments.

• Solaris Common Desktop Environment: User’s Guide


See Appendix C, “Recommended Reading” for a listing of all the CDE documentation.

How This Book Is Organized

This manual consists of these chapters and appendixes:

Chapter 1, “Moving to Motif and CDE,” provides a roadmap to using this manual, depending on what types of tasks you want to perform on your application.

Chapter 2, “Motif Environment,” contains information for developers writing Solaris Motif applications for either the OpenWindows or CDE environment.

Chapter 3, “Solaris Motif Toolkits,” describes the Solaris Motif 2.6 toolkit and identifies the non-standard parts of the Solaris 2.3 (IXI) Motif toolkit.
Chapter 4, “Development Environment Transition Issues,” compares and contrasts the OpenWindows and CDE development environments.

Chapter 5, “Toolkit Transition Issues,” discusses transitioning your application from an OPEN LOOK graphical user interface (GUI) to Solaris Motif.

Chapter 6, “Porting Issues and Ideas,” provides information to consider for porting your OPEN LOOK application to CDE.

Chapter 7, “Porting Example: OPEN LOOK to Solaris Motif,” presents a simple porting example.

Appendix A, “User Interaction Changes,” describes the user interaction changes from the OPEN LOOK to the CDE user model.

Appendix B, “Internationalization and CDE,” describes the things you must do differently from the OpenWindows environment to internationalize an application for the CDE desktop.

Appendix C, “Recommended Reading,” lists books and articles on issues related to OPEN LOOK, Motif, and CDE application development.

Related Books

For a list of the CDE documentation and reading material of interest to OPEN LOOK and Motif developers, see Appendix C, “Recommended Reading.”

Ordering Sun Documents

The SunDocs™ program provides more than 250 manuals from Sun Microsystems, Inc. If you live in the United States, Canada, Europe, or Japan, you can purchase documentation sets or individual manuals using this program.

For a list of documents and how to order them, see the catalog section of SunExpress™ On The Internet at http://www.sun.com/sunexpress.
**What Typographic Changes Mean**

The following table describes the type changes used in this book.

*Table P-1  Typographic Conventions*

<table>
<thead>
<tr>
<th>Typeface or Symbol</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>AaBbCc123</td>
<td>The names of commands, files, and directories; on-screen computer output</td>
<td>Edit your .login file. Use <code>ls -a</code> to list all files.</td>
</tr>
<tr>
<td>AaBbCc123</td>
<td>Command-line placeholder: replace with a real name or value</td>
<td>To delete a file, type <code>rm filename</code>.</td>
</tr>
<tr>
<td>AaBbCc123</td>
<td>Book titles, new words or terms, or words to be emphasized</td>
<td>Read Chapter 6 in <em>User's Guide</em>. These are called class options. You <em>must</em> be root to do this.</td>
</tr>
</tbody>
</table>

**Shell Prompts in Command Examples**

The following table shows the default system prompt and superuser prompt for the C shell, Bourne shell, and Korn shell.

*Table P-2  Shell Prompts*

<table>
<thead>
<tr>
<th>Shell</th>
<th>Prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td>C shell prompt</td>
<td><code>machine_name%</code></td>
</tr>
<tr>
<td>C shell superuser prompt</td>
<td><code>machine_name#</code></td>
</tr>
<tr>
<td>Bourne shell and Korn shell</td>
<td><code>$</code></td>
</tr>
<tr>
<td>Bourne shell and Korn shell</td>
<td><code>#</code></td>
</tr>
</tbody>
</table>
Moving to Motif and CDE

This chapter discusses the different types of Motif available to Solaris CDE developers, and provides the paths through this manual for the different tasks you may want to perform in relation to them.

Summary of Motif Toolkits

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary of Motif Toolkits</td>
<td>1</td>
</tr>
<tr>
<td>Moving to Motif</td>
<td>2</td>
</tr>
<tr>
<td>Moving to Solaris CDE</td>
<td>3</td>
</tr>
</tbody>
</table>

Summary of Motif Toolkits

This section summarizes the differences between the Motif toolkits supported by the Solaris environment. Any Solaris Motif application that is compiled on the Solaris 2.4, 2.5, or 2.5.1 operating system is binary compatible with Solaris 2.6 CDE.

- Solaris 2.6 Motif: Based on OSF/Motif 1.2.5 with additional bugfixes and enhancements. The Solaris 2.6 software always includes the Motif toolkit.
- Solaris 2.5.1 Motif: Based on OSF/Motif 1.2.3 with additional bugfixes and enhancements. The Solaris 2.5.1 software always includes the Motif toolkit.
- Solaris 2.5 Motif: Based on OSF/Motif 1.2.3 with additional bugfixes and enhancements. The Solaris 2.5 software always includes the Motif toolkit.
Solaris 2.4 Motif: Based on OSF/Motif 1.2.3 with additional bugfixes and enhancements. The exact release of Motif depends on what version of CDE has been installed on that system. The Solaris 2.4 software does not always include the Motif toolkit.

Motif available for Solaris 2.3: A version of IXI Motif based on OSF/Motif 1.2.2. An application compiled with this Motif library may not run on later versions of Solaris. However any Solaris 2.3 Motif application that is currently running on Solaris 2.4, 2.5, or 2.5.1 will run on Solaris 2.6 in the same way. The Solaris 2.3 software does not always include the Motif toolkit.

Note – In the Solaris CDE environment, you gain access to additional widgets (such as a menu button widget and a terminal emulator widget and library) through the libDtWidget library. See Chapter 3, “Solaris Motif Toolkits,” for more details.

Moving to Motif

Programming or porting tasks you probably want to perform in relation to Motif are:

- Running existing Motif applications on the OpenWindows 3.6 desktop
- Developing Solaris Motif applications for the OpenWindows 3.6 desktop

Running Existing Motif Applications on the OpenWindows Desktop

Any standard Motif 1.2 or Solaris Motif application will run on the OpenWindows 3.6 desktop.

Developing Solaris Motif Applications for the OpenWindows Desktop

If you are familiar with Motif and want to develop a Solaris Motif application for the OpenWindows 3.6 desktop, read Chapter 2, “Motif Environment.”

You might also want to read Chapter 3, “Solaris Motif Toolkits,” which compares the Motif toolkits that the Solaris environment supports.
If you are an OPEN LOOK developer and want to develop a Solaris Motif application for the OpenWindows 3.6 desktop, you should read the chapters and appendixes just mentioned in this section. In addition, read:

- Chapter 5, “Toolkit Transition Issues,” for a comparison of the OPEN LOOK and Motif graphical user interface (GUI) and widgets.
- Chapter 6, “Porting Issues and Ideas,” particularly those parts pertaining to GUI transitions.
- “Motif 1.2 Documentation” on page 77 and “Motif Programming” on page 79 for lists of books that will familiarize you with Motif programming.

### Moving to Solaris CDE

You do not need to port your OPEN LOOK or Motif application to the Solaris CDE environment for it to run on the Solaris CDE desktop. However, if you decide to port, refer to the CDE documentation and read the chapters mentioned below. See “CDE Documentation” on page 76 for a list of the available CDE documentation.

The main programming or porting tasks you probably want to perform in relation to Solaris CDE are:

- Running existing OLIT, XView, or Motif applications on the Solaris CDE desktop
- Porting OpenWindows applications to the Solaris CDE desktop
- Porting Motif applications to the Solaris CDE desktop
- Developing Solaris Motif applications for the Solaris CDE desktop

### Running Existing Applications on the Solaris CDE Desktop

Existing OLIT, XView, or Motif applications will run on the Solaris CDE desktop.

If you want your application to appear integrated with the Solaris CDE desktop but do not want to modify your application code, you can perform basic integration. This first level of Solaris CDE integration is described in “Basic Integration” on page 42.
Porting OpenWindows Applications to the Solaris CDE Desktop

Existing OpenWindows applications can run unmodified on the Solaris CDE desktop. If you want to move your applications to the Solaris CDE environment and to begin using its broader set of standard services, read this book to help you understand the differences between the OPEN LOOK and Motif toolkits, and the OpenWindows and Solaris CDE desktops.

Porting Motif Applications to the Solaris CDE Desktop

If your application is Motif 1.2 style guide-compliant, you are well on your way to it being CDE style guide-compliant. Solaris Motif is based on the Motif 1.2.3 or 1.2.5 toolkit and the CDE style guide is based on the Motif 1.2 style guide. Still, you may have to make some GUI changes to port your application to Solaris Motif.

To help port your Motif application to the Solaris CDE desktop, read:

- Chapter 3, “Solaris Motif Toolkits,” to find out about the enhancements in Solaris Motif and the CDE widgets available to you
- Chapter 4, “Development Environment Transition Issues,” which compares and contrasts the OpenWindows and Solaris CDE development environments

Refer to the checklist in the Common Desktop Environment: Style Guide and Certification Checklist to see how the CDE style guidelines are similar to and differ from those for Motif 1.2.

Developing and Debugging Applications for the Solaris CDE Desktop

Solaris CDE shared libraries are built with the latest Solaris loader technology to optimize their interfaces and performance. This technology conflicts with debuggers that were released prior to SPARCworks version 3.0.1. Therefore, use SPARCworks version 3.0.1 or later when developing and debugging applications in CDE.

Developing Solaris Motif Applications

If you are familiar with Motif and want to develop a Solaris Motif application for the Solaris CDE desktop, refer to the CDE documentation.
If you are an OPEN LOOK developer and want to develop a Solaris Motif application for the Solaris CDE desktop, read this book and refer to the CDE documentation.

In either case, see Appendix C, “Recommended Reading,” for a list of the CDE documentation as well as other books to help you with Motif programming.

**Solaris CDE Naming Conventions**

Solaris CDE uses the prefixes *DT* and *SDT* in uppercase and lowercase combinations, in names for desktop clients, desktop libraries, and so on. Do not use these prefixes in any Solaris CDE desktop application you write.
This chapter contains information for developers writing Solaris Motif applications for either the OpenWindows or Solaris CDE environment.

<table>
<thead>
<tr>
<th>Motif Packaging in the Solaris Software</th>
<th>7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compiling and Linking Motif Programs</td>
<td>8</td>
</tr>
<tr>
<td>Shared Library Policy</td>
<td>8</td>
</tr>
</tbody>
</table>

**Motif Packaging in the Solaris Software**

The Motif run-time support in the Solaris 2.6 software includes the following:

- Shared libraries
- Header files
- Key bindings
- ui1 compiler
- Man pages
- Demos and sample source

The Motif header files required for application development are located in /usr/dt/include. The Motif libraries are located in /usr/dt/lib.
Compiling and Linking Motif Programs

When you compile Motif programs, include the following compiler syntax to enable the compiler to find the Motif and X Window System™ header files:

```
-I/usr/dt/include -I/usr/openwin/include
```

Use the following compiler syntax to direct the linker to the correct shared libraries as shown in the following:

```
```

The following is an example of a compile-and-link line for a Motif application:

```
cc -o myprog -I/usr/dt/include -I/usr/openwin/include myprog.c -R/usr/dt/lib \ 
-R/usr/openwin/lib -L/usr/dt/lib -lXm -L/usr/openwin/lib -lXt -lX11
```
This chapter provides some information about Solaris 2.6 Motif and IXI Motif, and introduces the widgets available for Solaris CDE application development.

<table>
<thead>
<tr>
<th>Motif Toolkits in Solaris Software</th>
<th>9</th>
</tr>
</thead>
<tbody>
<tr>
<td>Widgets Available for CDE Application Development</td>
<td>12</td>
</tr>
</tbody>
</table>

**Motif Toolkits in Solaris Software**

This section discusses the Solaris 2.6 Motif and IXI Motif toolkits. For a summary of the differences between the Motif toolkits available for Solaris application development, see “Summary of Motif Toolkits” on page 1.

**Solaris 2.6 Motif**

Solaris 2.6 Motif is based on OSF/Motif 1.2.5 with additional bugfixes and enhancements. The Solaris 2.6 software always includes the Motif toolkit.
Enhancements to Existing OSF/Motif 1.2.5 Functionality

The Solaris Motif library contains minor enhancements to OSF/Motif 1.2.5 usability to emulate certain OPEN LOOK user interface and Microsoft® Windows features. The usability enhancements include:

- Optionally allowing mouse button 2 on a three-button mouse to be used to extend the current selection. This is equivalent to the OPEN LOOK Adjust function.
- Allowing mouse button 3 to activate a CascadeButton menu (for OPEN LOOK compatibility).
- Ability to re-map keybindings to be consistent with those for OPEN LOOK or Microsoft Windows applications.

Solaris CDE Libraries for Motif

Motif Library (libXm)

Solaris CDE provides all the Motif 1.2.5 header files. The Solaris CDE libraries for Motif are the Motif 1.2.5 libraries with bug fixes and enhancements.

Motif UIL library (libUill)

The Motif user interface language (UIL) is a specification language for describing the initial state of a Motif application’s user interface. The CDE version of the Motif UIL library is essentially unchanged from the Motif 1.2.5 version.

Include the UilDef.h header file (found in the /usr/dt/include/uil directory) to access UIL.

Motif Resource Manager Library (libMrm)

The Motif resource manager (MRM) is responsible for creating widgets based on definitions contained in user interface definition (UID) files created by the UIL compiler. MRM interprets the output of the UIL compiler and generates the appropriate argument lists for widget creation functions. Use libMrm to access the Motif resource manager. The CDE version is essentially unchanged from the Motif version.
Include the Mrm/MrmPublic.h header files to access libMrm in your application.

Related Documentation

See the OSF/Motif Programmer’s Reference for information on UIL, the UIL compiler, UID, and Mrm.

IXI Motif 1.2.2 Toolkit

The IXI Motif 1.2.2 toolkit, which was available for Solaris 2.3 software development, contains some incompatibilities with standard OSF/Motif 1.2.2. These features are not part of the OSF/Motif 1.2 specification, and are not present in the Solaris 2.4 and later Motif toolkits.

XmList convenience functions

The following are the non-standard functions in IXI Motif. Remove them from your application code if you have used them:

- XmListRecolorItem
- XmListRecolorPos
- XmListSetClientDataPos
- XmListSetClientDatasPos

XmForm widget

The XmForm widget implementation in IXI Motif and OSF/Motif 1.2.2 are different, although the APIs are identical. Hence, applications linked with IXI Motif can exhibit minor behavioral or visual differences in the XmForm widget when they are re-linked with OSF/Motif.

The Solaris Motif toolkits use the OSF/Motif XmForm widget implementation, which is binary compatible with the OSF/Motif 1.2.2, but not the IXI Motif, XmForm widget.
Widgets Available for CDE Application Development

This section discusses the widgets available for Solaris CDE application development, as an extension to Solaris Motif.

Solaris Motif Control Widgets

The Solaris Motif control widgets are designed to ease porting OPEN LOOK applications to the Solaris CDE desktop by providing equivalent functionality in Solaris Motif. These widgets are not considered to be part of Solaris Motif, but rather an extension to Solaris Motif. The libDtWidget library contains widgets and functions that are used to provide common functionality across all CDE applications. The widgets provided include:

Table 3-1  CDE Control Widgets

<table>
<thead>
<tr>
<th>Widget Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DtSpinBox</td>
<td>TextField widget with additional controls for incrementing and decrementing numeric values, or browsing through and selecting from a list of text strings. Can be read-only. DtSpinBox is functionally similar to the OPEN LOOK numeric text field.</td>
</tr>
<tr>
<td>DtComboBox</td>
<td>Combination of TextField and pop-up list widgets that provides a list of valid choices for the TextField. Can be read-only.</td>
</tr>
<tr>
<td>DtMenuButton</td>
<td>Command widget that provides the menu cascading functionality of an XmCascadeButton widget outside of a menu bar, or a menu pane. DtMenuButton is functionally equivalent to the OPEN LOOK menu button.</td>
</tr>
</tbody>
</table>
Examples of each type of widget follow:

• Text field and arrow button widget (**DtSpinBox**)

  ![Text field and arrow button widget](image)

• Text field and list box widget (**DtComboBox**)

  ![Text field and list box widget](image)

• Menu button widget (**DtMenuButton**)

  ![Menu button widget](image)
The DtComboBox custom widget calls the Selection Callback of the Combo Box widget, instead of the List widget, when the browseSelectCallback or the defaultActionCallback is triggered for the List widget of a Combo Box.

This action may cause failure for applications that rely on the List widget Selection callback to be called when the List widget’s browseSelectCallback or defaultActionCallback is triggered.

Note – The Solaris CDE software supports all Motif 1.2 widgets.

Compatibility with Motif 2.0

The APIs of the DtSpinBox and DtComboBox widgets are similar to the Motif 2.0 release of XmSpinBox and XmComboBox widgets. The APIs are designed so an application can easily switch to the Motif 2.0 version of these widgets. The main thing you need to do to switch is to change the Dt names for the class, types, and creation routines to Xm.

This information is supplied in case you choose to port your application to Motif 2.0 but this is not a recommendation that you do so.

Note – The Solaris CDE software does not guarantee strict API or binary compatibility between its widgets and the Motif 2.0 widgets.

Library and Header Files

The library libDtWidget provides access to the DtSpinBox, DtComboBox, and DtMenuButton widgets. The libDtWidget header files for these widgets are:

- Dt/SpinBox.h
- Dt/ComboBox.h
- Dt/MenuButton.h

Demo Programs

You can find the Solaris Motif control widgets demos in /usr/dt/examples/dtwidget. Read the README file for detailed information on the demos.
Related Documentation

For more information on Solaris Motif control widgets, see the relevant man pages and Common Desktop Environment: Programmer’s Guide.

CDE Terminal Widget

The DtTerm widget is part of the Solaris CDE development environment. It provides the functionality required to emulate an ANSI X3.64-1979-style terminal (specifically a DEC® VT220-like terminal with extensions). The Terminal widget library, libDtTerm, provides the DtTerm widget for adding a terminal window to a GUI. If you include a terminal in your application, use Solaris Motif widgets to add display enhancements to it such as pop-up menus and scrollbars.

The Solaris CDE Terminal application, which is a part of the run-time environment, is a window that behaves as a terminal, enabling access to traditional terminal-based applications from within the desktop. The DtTerm widget is the foundation for the desktop run-time terminal.

The libDtTerm library includes a set of convenience functions to create, access, and support the DtTerm widget.

Library and Header Files

The libDtTerm library provides a set of widgets based on Motif for designing a terminal or for adding a terminal window to a GUI.

Include the Dt/Term.h header file to access libDtTerm APIs in your application.

Demo Programs

You can find the DtTerm demos in /usr/dt/examples/dtterm. See the README file for detailed information on the demos.

Related Documentation

For more information on the DtTerm widget, see the relevant man pages.
For more information on the desktop terminal application, see the terminal help volume, the relevant man pages, or *Solaris Common Desktop Environment: User’s Guide*.

**Text Editor Widget**

The CDE text editing system consists of two components:

- The Text Editor application, which provides editing services through graphical, action, and ToolTalk interfaces
- The editor widget, `DtEditor`, which provides a programmatic interface for the following editing services:
  - Cut and paste
  - Search and replace
  - Simple formatting
  - Spell checking (for 8-bit locales)
  - Undo previous edit
  - Enhanced I/O handling capabilities that support input and output of ASCII text, multibyte text, and buffers of data
  - Support for reading and writing files directly

Although the Motif text widget also provides a programmatic interface, applications that want to assure a system-wide uniform editor should use the `DtEditor` widget. The CDE Text Editor and Mailer applications use the editor widget. Use this widget in the following circumstances:

- You need the functionality, such as spell checking, undo, and find/change, that is provided by the `DtEditor` widget.
- You want users to be able to read and write data to and from a file.
- When your program does not need to edit the text while the widget has control of the text.

**Library and Header Files**

The `DtEditor` widget is in the `libDtWidget` library. The header file is `Dt/Editor.h`.
Demo Programs

A demo containing an example of the DtEditor widget (editor.c) is in /usr/dt/examples/dtwidget directory. Read the README file for detailed information on the demo.

Related Documentation

For more information on the Text Editor widget, see the relevant man pages and Common Desktop Environment: Programmer’s Guide.
If you want to port an OPEN LOOK or Motif application to the Solaris CDE desktop, you need to consider the development environment transition as well as the graphical user interface (GUI) transition. The OpenWindows and Solaris CDE development environments are different in many ways but similar in others. This chapter compares and contrasts the two development environments.

The Solaris CDE desktop is based on the same X server as is part of the OpenWindows environment. For example, you can access Display PostScript™ (DPS), and the XIL™ and XGL™ libraries from Solaris CDE.

**Features Exclusive to Solaris CDE**

This section briefly describes the features of the Solaris CDE development environment that do not appear in the OpenWindows environment in any analogous form.

- Desktop Korn shell: Provides a way to engage in graphic user interaction through shell scripts. See *Common Desktop Environment: Desktop KornShell User’s Guide* for detailed information on desktop Korn shell.
• Workspace Manager: Provides support for multiple workspaces. Each workspace is a *virtual screen*. Most desktop applications can run as expected without knowledge of the Workspace Manager. See *Common Desktop Environment: Programmer’s Overview* and *Common Desktop Environment: Programmer’s Guide* for more information on the Workspace Manager.

**OpenWindows Versus Solaris CDE Development Environments**

This section contrasts some of the functionality that OpenWindows and Solaris CDE development environments have in common, but that might be implemented differently.

**GUI Application Builders**

Both the OpenWindows and Solaris CDE development environments contain GUI application builders.

• The OpenWindows Developer’s Guide (Devguide) is a tool that helps produce the GUI for OPEN LOOK applications. Devguide has code generators that produced XView and OLIT source code. The Devguide Motif Conversion Utilities product, which was first shipped with the Solaris 2.3 release, produces Motif code from Devguide GIL files.

• CDE Application Builder (App Builder) produces Solaris Motif code. It also enables you to integrate some of the desktop services into your application; for example, drag and drop, ToolTalk messaging, sessioning, help, and internationalization. If you used Devguide to create your application, you can use App Builder’s GIL-to-BIL converter to create BIL files, which is the format the App Builder uses.

If you have used Devguide to build an application, the CDE Application Builder will feel very familiar to you. The palette is visually similar. Much of the Devguide functionality is retained, such as the Build and Test feature and the ability to build projects.

Drag and Drop

The underlying basic functionality of OpenWindows drag and drop and CDE drag and drop are similar. Both versions of drag and drop contain general purpose APIs that provide the same outcome from a user’s perspective.

However, CDE drag and drop also provides a convenience API that serves two purposes:

- It is easier to use than the APIs that Motif 1.2.3 provides
- It defines and implements data transfer policies

The OpenWindows environment has conventions for drag and drop policies, but it is up to the developer to implement the policies. If you use drag and drop in your OPEN LOOK application, much of the data transfer code you wrote can be condensed by using the CDE convenience APIs.


ToolTalk Messaging

OpenWindows ToolTalk messaging is compatible with the CDE ToolTalk Messaging Service. In addition to the OpenWindows ToolTalk functionality, the CDE ToolTalk Messaging Service provides:

- Two standard ToolTalk protocols known as message sets
- ttrace
  
  The ttrace utility is a debugging tool that helps monitor ToolTalk API calls and ToolTalk’s internal message processing.

- ttsnoop

  The ttsnoop utility is a debugging tool that helps monitor messages that are sent between your application and other applications.

See Common Desktop Environment: Programmer’s Overview, Common Desktop Environment: ToolTalk Messaging Overview, and the ttrace(1) and ttsnoop(1) man pages for more information on the CDE extensions of ToolTalk.
**Typing**

The OpenWindows *classing engine* identifies the characteristics, or attributes, of files. The classing engine specifies attributes such as print method, icons, and open commands for specific file types. The classing engine consists of two parts:

- A database that stores file type names and attributes
- A collection of routines that query the database

The Solaris CDE *data typing* and *actions* form the analog of the classing engine. The data-typing mechanism consists of two tables (DATA_ATTRIBUTES and DATA_CRITERIA) that specify attributes such as icons, actions, and commands for specific file types. DATA_CRITERIA corresponds to the classing engine’s File name space. DATA_ATTRIBUTES corresponds to the classing engine’s Type name space. The actions field in the DATA_ATTRIBUTES table corresponds to the former print and open methods in the classing engine. In the Solaris CDE development environment, it acts as a reference to another table called ACTION, and is greatly enhanced over the former classing engine methods.

See *Common Desktop Environment: Programmer’s Overview* and *Common Desktop Environment: Programmer’s Guide* for more information on data typing and actions.

**Help**

CDE help differs from OpenWindows help in three areas:

- User model
- Programming tasks
- Richness of help system

See *Common Desktop Environment: Programmer’s Overview* and *Common Desktop Environment: Help System Author’s and Programmer’s Guide* for more information on the CDE help system.

**User Model**

The OpenWindows user model is very simple. The user places the pointer over the portion of the application he wants help on, and presses the Help key.
The CDE user model is similar but slightly different. The user receives help from that portion of the application that has input focus. That is, the user must select a portion of the application and then press the Help key to receive help on that portion.

CDE help provides on item help for those objects that cannot get input focus. You must provide an On Item selection in your application’s Help menu so users can access help for those items.

**Programming Tasks**

Writing OLIT and XView help is very similar. In either case, your application provides the text appropriate for a widget or object, respectively. The OpenWindows window manager determines which application is responsible when the user presses the Help key, and dispatches an event to that application.

OLIT has a specialized Help widget, and XView has a Help frame, that puts the right information into the Help dialog display area and makes the dialog appear on the screen. You either have to include a function call to `OLRegisterHelp()` in OLIT, or set an object attribute in XView, to enable help on a widget (object).

To provide CDE help with your application, you must:

1. Establish help callbacks on all relevant widgets.
   These callbacks must be able to provide the help information for the associated widgets.

2. Create and manage the help dialogs.
   CDE provides `DtHelpDialog` and `DtHelpQuickDialog` widgets to create help dialog boxes and quick help dialogs. CDE has one shared help dialog that displays help.

3. Implement on item help.
   Common Desktop Environment: Help System Author’s and Programmer’s Guide provides source code to do this.
Richness of Help System

OpenWindows help has a single help dialog in which you can place text only. CDE help is much richer. CDE provides both quick and full help. You can also include much more than just text in your help dialogs; for example, color graphics and hyperlinks. The user can print help and also use navigation facilities to stack and traverse help attached to different widgets.

Internationalization

You can internationalize an OpenWindows, as well as a CDE, application. The steps to internationalize an OpenWindows application that are different in CDE than in the OpenWindows environment are documented in Appendix B, “Internationalization and CDE.”


Fonts

In the OpenWindows environment, the default font type is Lucida. The same is true for the CDE desktop, so the CDE user will see no font style differences from the OpenWindows desktop.

Fonts in the OpenWindows environment have proprietary font names, whereas CDE is open. All CDE font names start with -dt- and are common across all CDE platforms. Both CDE and OpenWindows fonts follow the X11 XLFD font specifications.

In both the OpenWindows and CDE environments, your application should not override the system font defaults. This enables the user to customize his desktop. In the OpenWindows environment, the user can choose font type and style through the Workspace Properties desktop application. In CDE, the user can choose font size through the Style Manager.

In the OpenWindows environment, you have to specify fonts for any locale in which you want your application to run. By using the CDE Interface fonts, your application will run the same across all locales and desktops. If you use Application fonts, you must still specify fonts for Asian locales.
The CDE font aliases are in /usr/dt/config/xfonts/<locale>, where <locale> is the directory corresponding to the locale in which you are interested. The default font resources that the Style Manager uses are in /usr/dt/config/<locale>/sys.fonts.


**Motif Applications and Color**

The CDE environment changes the color threshold values for Motif; hence, Motif applications may have different colors under Solaris CDE from those in the OpenWindows environment.
This chapter describes toolkit terminology, common widgets, CDE exclusive widgets, and high-level widgets, and provides information about the different libraries.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OPEN LOOK Versus Solaris Motif Toolkits</strong></td>
<td>27</td>
</tr>
<tr>
<td><strong>XView Libraries Versus Solaris Motif Libraries</strong></td>
<td>31</td>
</tr>
<tr>
<td><strong>OLIT Libraries Versus Solaris Motif Libraries</strong></td>
<td>35</td>
</tr>
</tbody>
</table>

**OPEN LOOK Versus Solaris Motif Toolkits**

When you compare an OPEN LOOK application with its Solaris Motif counterpart, a few contrasting visual elements are immediately apparent. For example, the OPEN LOOK buttons are round whereas the Solaris Motif buttons are square. The shading applied to buttons and other objects for a three-dimensional appearance are also different. Although such cosmetic elements do not affect a program’s behavior, and can often be disregarded when porting, your application will not be CDE style-guide compliant if you deviate from the CDE look.

Several differences are often significant in a conversion effort. The most critical of these features and other GUI elements are summarized in three sections:
• Aspects of the OPEN LOOK user interface that are missing from Solaris Motif
• Aspects of Solaris Motif that do not appear in the OPEN LOOK user interface
• Features or other elements that appear in both specifications but are implemented differently

See the Preface for a list of style guides and other references that describe the OPEN LOOK and Solaris Motif GUIs.

See Appendix A, “User Interaction Changes,” for a more detailed list of the user interaction changes from OPEN LOOK to CDE.

**Features Only in the OPEN LOOK User Interface**

The following features are found in the OPEN LOOK user interface and are implemented in XView or OLIT (or both) but do not appear in Solaris Motif:

• Split window control
• Scrollbar anchors
• Defaults of the menu
  • Automatic default; shortcut method for selecting the default
  • Default menu item indicated by a ring
• Font chooser widget
• Pointer warping in notices
• Can drop onto minimized windows (icons)

**Features Only in the Solaris Motif User Interface**

The following features are found in Solaris Motif and not in the OPEN LOOK user interface:

• Front Panel
• Tools for producing and registering help volumes with hypertext capabilities
• Additional user interface objects (widgets) available for applications and specified in the CDE Style Guide
Notable Implementation Differences Between Toolkits

Many features are roughly equivalent in the OPEN LOOK user interface and Solaris Motif but have significant implementation differences. The following are the most important differences:

• Tear off Menus
• Input focus indicators
• Widget classes (sliders and gauges versus scales, for example)
• Secondary text selections

Other significant differences include the following:

• Keyboard bindings
• The window manager controls associated with each window
• Internalization
• Mouse button behavior

The remainder of this section provides information on some of these features.

Tear-off Menus

In Solaris Motif, tear-off menus replace the pinned menus of the OPEN LOOK user interface. Selecting the dashed line on the top of the menu “tears-off” the menu.

Secondary Text Selection

The OPEN LOOK secondary text selection is roughly analogous to the Motif quick transfer mechanism.

Window Controls

One of the most critical implementation differences involves window controls. When the Motif user presses the Window menu button in the upper left corner of the title bar, or the OPEN LOOK user presses the MENU button anywhere on the window background (including the header), a menu is displayed. The options offered under the two GUIs introduce a key contrast.
The Motif Window menu offers a choice of Restore, Move, Size, Minimize, Maximize, Lower, and Close. The OPEN LOOK base Window menu offers Close, Full Size, Properties, Back, Refresh, and Quit. The two lists are fundamentally the same, but have very different effects.

In the OPEN LOOK user interface, the Close option minimizes (iconifies) the window, and Quit terminates the application.

In Motif, the Minimize option minimizes the window, and the Close option terminates the application. Many users familiar with the OPEN LOOK user interface have found themselves exiting a Motif program when their intent was to close its window to an icon.

**Mouse Button Behavior**

The structure of the mouse buttons is very similar in both specifications; however, the difference is significant enough to cause some confusion.

Table 5-1 shows the default left-to-right mapping of the three OPEN LOOK mouse buttons.

<table>
<thead>
<tr>
<th>BUTTON</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SELECT</td>
<td>Specifies an object or manipulates objects and controls, drag</td>
</tr>
<tr>
<td>ADJUST</td>
<td>Extends or reduces the number of selected objects</td>
</tr>
<tr>
<td>MENU</td>
<td>Displays a menu associated with the pointer location or specified object</td>
</tr>
</tbody>
</table>

The three Motif mouse button assignments, described in Table 5-2, also start by default with the left mouse button.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BSelect</td>
<td>Selects, activates, and sets the location cursor, drag</td>
</tr>
<tr>
<td>BTransfer</td>
<td>Moves and copies elements, drag and drop transfer. Can be customized to be the OPEN LOOK Adjust button.</td>
</tr>
<tr>
<td>BMenu</td>
<td>Displays menus</td>
</tr>
</tbody>
</table>
XView Libraries Versus Solaris Motif Libraries

This section compares the XView and Solaris Motif libraries.

Terminology

The XView toolkit and the Xt (OLIT and Motif) toolkits use the following terminology:

<table>
<thead>
<tr>
<th>XView</th>
<th>Xt (OLIT and Motif)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Package</td>
<td>Widget</td>
</tr>
<tr>
<td>Attribute</td>
<td>Resources</td>
</tr>
<tr>
<td>Frame</td>
<td>Shell</td>
</tr>
</tbody>
</table>

XView is based directly on Xlib, whereas Motif is based on the Intrinsics (Xt) toolkit and the Intrinsics toolkit is based on Xlib.

<table>
<thead>
<tr>
<th>XView</th>
<th>OLIT</th>
<th>Motif</th>
</tr>
</thead>
<tbody>
<tr>
<td>XLib</td>
<td>Xt</td>
<td>Xt</td>
</tr>
<tr>
<td></td>
<td>XLib</td>
<td>XLib</td>
</tr>
</tbody>
</table>

Because of this fundamental difference, the basic library functions to initialize the environment and create, modify and destroy graphical objects, are different, as shown in the following examples:

<table>
<thead>
<tr>
<th>XView</th>
<th>Motif/Xt</th>
</tr>
</thead>
<tbody>
<tr>
<td>xv_init()</td>
<td>XtAppInitialize()</td>
</tr>
<tr>
<td>xv_create()</td>
<td>XtCreateWidget()</td>
</tr>
<tr>
<td>xv_set()</td>
<td>XtSetValues()</td>
</tr>
<tr>
<td>xv_destroy()</td>
<td>XtDestroyWidget()</td>
</tr>
</tbody>
</table>

Functions that deal with event handling callbacks, and internationalization features, for example, get more complicated. For these features, simple one-to-one correspondence does not exist.
OPEN LOOK Versus Motif Toolkit Architecture

OLIT and Motif have very similar architectures whereas XView and Motif do not. When migrating from XView to Motif, you should note these toolkit differences.

The XView toolkit implements both the user interface objects, called packages, and the routines and processes that hold the interface together (creation routines, event processing, and so on), while Motif and OLIT implement basically just the user interface object, widgets, leaving the routines and processes to the Intrinsics library. For example, `xv_init()` is a function that is in the XView library. The corresponding function to use for OLIT or Motif programming, `XtAppInitialize()`, is in the Xt Intrinsics library.

The three toolkits represent two different GUIs. The appearance of the XView and OLIT toolkits are similar, whereas the appearance of Solaris Motif is noticeably different. Although there is a rough one-to-one correspondence between the function calls in the libraries, the behavior of parallel programs is different. That is, even after an OLIT (or XView) program has been converted to use the Solaris Motif library, it still to some degree has an OPEN LOOK appearance. A program in such a state does not adhere to either style completely.

Programming Model

Although the APIs are different, both XView and Motif are based on the same object-oriented methodology for programming a user interface:

- Initialize the toolkit
- Instantiate user interface objects
- Register callbacks on the user interface objects
- Enter event loop, waiting for user to generate events on the user interface objects

The overall structure of a program being ported from XView to Motif can remain intact even though all the function calls must be converted from one API to the other.
Common Types of User Interface Objects

Both XView and Motif are user interface toolkits that support some common types of user interface objects. However, XView implements many of these objects at a higher level that requires more than one Motif widget to produce the equivalent of a single XView object.

Table 5-3 lists the basic mapping of common objects for XView and its equivalent Solaris Motif widget:

Table 5-3  Basic Mapping of Common Objects.

<table>
<thead>
<tr>
<th>XView Package</th>
<th>Equivalent Solaris Motif Widget</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base Frame</td>
<td>XmTopLevelShell + XmMainWindow</td>
</tr>
<tr>
<td>Command Frame</td>
<td>XmDialogShell + XmBulletinBoard</td>
</tr>
<tr>
<td>Notice</td>
<td>XmDialogShell + XmMessageBox (MessageDialog)</td>
</tr>
<tr>
<td>Canvas</td>
<td>XmScrolledWindow + XmDrawingArea</td>
</tr>
<tr>
<td>Panel</td>
<td>XmBulletinBoard or XmForm</td>
</tr>
<tr>
<td>Panel Button</td>
<td>XmPushButton</td>
</tr>
<tr>
<td>Menu Button</td>
<td>DtMenuButton (not accessible in OpenWindows environment)</td>
</tr>
<tr>
<td>Abbrev Menu Button</td>
<td>XmRowColumn (Option Menu)</td>
</tr>
<tr>
<td>Checkbox</td>
<td>XmRowColumn + XmToggleButton (CheckBox)</td>
</tr>
<tr>
<td>Exclusive Choice</td>
<td>XmRowColumn + XmToggleButton (Radio Box)</td>
</tr>
<tr>
<td>Scrolling List</td>
<td>XmScrolledWindow + XmList</td>
</tr>
<tr>
<td>Message</td>
<td>XmLabel</td>
</tr>
<tr>
<td>Slider</td>
<td>XmScale</td>
</tr>
<tr>
<td>Text Field</td>
<td>XmTextField</td>
</tr>
<tr>
<td>Numeric Text Field</td>
<td>DtSpinBox (not accessible in OpenWindows environment)</td>
</tr>
<tr>
<td>Text SubWindow</td>
<td>XmScrolledWindow + XmText (ScrolledText)</td>
</tr>
<tr>
<td>TTY SubWindow</td>
<td>XmScrolledWindow + DtTerm (not accessible in OpenWindows environment)</td>
</tr>
</tbody>
</table>
Differences Between XView and Solaris Motif

XView abstracts a number of other X11 functions that Motif (Xt) does not. In order to get equivalent functionality in Motif, these must be re-coded with direct Xlib calls.

The XView packages with no Motif equivalents are:
- Icon
- Server Image
- Colormap Segment (CMS)
- Cursor
- Fullscreen
- Server
- Font

Additionally, no Solaris Motif equivalent exists for the OPEN LOOK user interface functionality that splits windows into different views. To implement this function, you must subclass one of the Motif Manager widgets.

Some XView functions can be coded with the Motif/Xt API; however, these APIs are significantly different, and require complete redesign and recoding. These functions are:

<table>
<thead>
<tr>
<th>XView API</th>
<th>Motif/Xt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection service</td>
<td>Xt selection API</td>
</tr>
<tr>
<td>Drop target package</td>
<td>Motif drag-and-drop API¹</td>
</tr>
<tr>
<td>Notifier</td>
<td>Xt event management API</td>
</tr>
</tbody>
</table>

¹ If you are porting to CDE, use the CDE drag-and-drop API. It is an extension of the Motif 1.2 drag-and-drop API and is easier to use.
X Resources

The X resources that control the behavior and appearance of XView and Motif applications are different. XView objects may not necessarily have instance names attached to them, unlike Motif/Xt objects. XView resources are independent of instance names. For example, Window.Foreground.Color affects all relevant XView objects.

Motif/Xt resources contain either class or instance names, for example, mainframe.control_panel.button1.foreground. To make Xt resources affect more than one object, use wildcards and class names.

External Files

XView reads in several files at start-up time ranging from message files to application specific default files containing X resources. The content and location of some of these files are different from Motif. (For example, Motif/Xt does not read in a message domain file (.mo file) under $OPENWINHOME.) The internationalization messaging scheme is completely different for Motif.

OLIT Libraries Versus Solaris Motif Libraries

Solaris Motif and OLIT support a number of convenience routines that are useful in manipulating objects in the user interface.

Routines Only in OLIT Library

These features are unique to the OLIT library.

- Error-Handling Routines
  OLIT provides a range of routines to enable the application to customize error handling.

- Dynamic Resources
  OLIT provides support for the user to dynamically change the value of certain resources (such as colors or fonts) after an application has been invoked.
Routines Only in Solaris Motif Libraries

These features are unique to the Solaris Motif libraries.

• UIL Support

Solaris Motif supports the engine for using UIL definitions for the user interface layout. This separation allows the user interface to be modified without recompiling the program’s executables. OLIT’s Devguide solution (golit) provides similar functionality by allowing the user interface to be defined in GIL file format; however, the application must be recompiled when the user interface changes.

• Clipboard Routines

Solaris Motif provides a library for managing the clipboard and its selections.

• Widget-Creation Routines

Solaris Motif provides a complete set of routines that create a particular type of widget or group of widgets.

• Compound String Support

Solaris Motif requires the user of compound strings for most text. To support these special string formats, Solaris Motif includes a number of routines to create and manipulate compound strings.

Widgets

Both the OLIT and Solaris Motif toolkits support a number of common widgets and gadgets with similar functionality, and each supports a number of more exclusive widgets. If a widget is implemented in one toolkit but not in the other, you can often build an equivalent object using multiple widgets in the other toolkit.
Table 5-4 matches the common widget name to the actual class name of the widget in each toolkit.

**Table 5-4  Common Widget Mapping**

<table>
<thead>
<tr>
<th>OLIT Class Name</th>
<th>Solaris Motif Class Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>BulletinBoard</td>
<td>XmBulletinBoard</td>
</tr>
<tr>
<td>DrawArea</td>
<td>XmDrawingArea</td>
</tr>
<tr>
<td>ExclusiveChoice + RectButtons</td>
<td>XmRowColumn + XmToggleButton (Radio Box)</td>
</tr>
<tr>
<td>Form</td>
<td>XmForm</td>
</tr>
<tr>
<td>Manager</td>
<td>XmManager</td>
</tr>
<tr>
<td>MenuButton</td>
<td>DtMenuButton (not accessible in OpenWindows environment)</td>
</tr>
<tr>
<td>NoticeShell</td>
<td>XmDialogShell + XmMessageBox</td>
</tr>
<tr>
<td>AbbrevMenuButton</td>
<td>XmRowColumn (Option Menu)</td>
</tr>
<tr>
<td>PopupWindowShell</td>
<td>XmDialogShell</td>
</tr>
<tr>
<td>NonExclusiveRectButton</td>
<td>XmRowColumn + XmToggleButton (Check Box)</td>
</tr>
<tr>
<td>PopupMenuShell</td>
<td>XmMenuShell</td>
</tr>
<tr>
<td>Primitive</td>
<td>XmPrimitive</td>
</tr>
<tr>
<td>OblongButton</td>
<td>XmPushButton</td>
</tr>
<tr>
<td>ControlArea</td>
<td>XmRowColumn</td>
</tr>
<tr>
<td>Scrollbar</td>
<td>XmScrollBar</td>
</tr>
<tr>
<td>ScrollingList</td>
<td>XmList + XmScrolledWindow</td>
</tr>
<tr>
<td>ScrolledWindow</td>
<td>XmScrolledWindow</td>
</tr>
<tr>
<td>Slider</td>
<td>XmScale</td>
</tr>
<tr>
<td>StaticText</td>
<td>XmLabel</td>
</tr>
<tr>
<td>TextEdit</td>
<td>XmText</td>
</tr>
<tr>
<td>TextField</td>
<td>XmTextField</td>
</tr>
<tr>
<td>RectButton</td>
<td>XmToggleButton</td>
</tr>
</tbody>
</table>
Widgets Exclusive to Solaris Motif

This section briefly describes the widgets that are exclusive to Solaris Motif.

Note – These widgets are also available for Motif development in the OpenWindows environment, except for the DtTerm, DtEditor, DtComboBox, DtSpinBox, and DtMenuButton widgets.

- DtTerm
  This widget provides the functionality required to emulate an ANSI X3.64-1979-style terminal emulator (specifically a DEC VT220-like terminal with extensions).

- DtEditor
  This widget provides a programmatic interface for editing services such as cut and paste.

- DtComboBox
  This widget is a combination of a text field and a list widget that provides a list of valid choices for the text field. Selecting an item from this list automatically fills the text field with that list item.

- DtSpinBox
  This widget is a convenient user interface control that increments and decrements an arbitrary TextField.

- DtMenuButton
  This widget is a command widget that complements the menu cascading functionality of an XmCascadeButton widget. (OLIT has its own menu button widget, with equivalent functionality to DtMenuButton.)

- XmArrowButton
  This button is a primitive push button widget that displays an arrow label.

- XmCommand
  This is a manager widget that builds a command box and manages the user-selected commands and command history.
• XmDrawnButton

This button is a primitive push button whose label can be drawn by the program.

• XmFrame

This manager widget is used to parent a single child and enclose that child with a frame or border.

• XmLabelGadget

This gadget is a low-overhead object for read-only text.

• XmMainWindow

This manager widget supports a menu bar, command area, and work area.

• XmPanedWindow

This manager widget implements resizeable panes within a window.

• XmSelectionBox

This widget box allows you to select one item from a list in a general dialog box.

• FileSelectionBox

This widget provides a standard way to select a file (typically for the application to read or write).

The libDtWidget library, which contains the DtComboBox, DtSpinBox, DtMenuButton and DtEditor widgets, depends directly on the following libraries:

• Xm library for the Motif superclass support
• Xt library for creation and manipulation of widgets
• X library for the base X Window System
Widgets Exclusive to OLIT

This section briefly describes the widgets that are exclusive to OLIT.

- **DropTarget**
  This primitive widget implements both the source and destination ends of drag-and-drop operations.

- **FlatWidget**
  These special widgets manage any number of subobjects within the context of a single widget. When implementing menus or choice objects that contain many subitems, they provide a significant memory savings.

- **FooterPanel**
  This manager widget automatically supports a window with a floating footer area.

- **RubberTile**
  This manager widget allows relative-sizing constraints to be placed on its children.

- **Stub**
  This primitive widget enables you to customize its behavior without subclassing.
Porting Issues and Ideas

This chapter discusses porting OPEN LOOK applications to Solaris Motif on the Solaris CDE desktop. Much of the information presented is generic enough to encompass porting from OPEN LOOK to Motif running on the OpenWindows desktop.

<table>
<thead>
<tr>
<th>Elements of Migrating</th>
<th>42</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do You Need to Port?</td>
<td>42</td>
</tr>
<tr>
<td>If You Decide to Port</td>
<td>43</td>
</tr>
<tr>
<td>Start Small</td>
<td>45</td>
</tr>
<tr>
<td>Architectural Impact</td>
<td>46</td>
</tr>
<tr>
<td>Use Transition Tools</td>
<td>49</td>
</tr>
<tr>
<td>Use Existing Code</td>
<td>51</td>
</tr>
<tr>
<td>Tips</td>
<td>52</td>
</tr>
<tr>
<td>Summary: Things to Keep in Mind</td>
<td>53</td>
</tr>
</tbody>
</table>
Elements of Migrating

Migrating from the OPEN LOOK user interface to Motif is complex. It generally will not amount to a widget-for-widget swap. Do not expect it to be as straightforward as a line-by-line code translation. Depending on your application, the migration can range from a major architectural impact down to subtle widget differences.

Besides migrating from the OPEN LOOK user interface to Motif, porting to the Solaris CDE desktop means that you have the Solaris CDE development environment infrastructure available to your application. See Chapter 4, “Development Environment Transition Issues,” for a summary of some of these features. See Common Desktop Environment: Programmer’s Overview for a more detailed description of the development environment components and documentation.

Do You Need to Port?

First you should decide whether you really have to port your application. As mentioned in “Running Existing Applications on the Solaris CDE Desktop” on page 3, OPEN LOOK and Motif applications run “as is” on the Solaris CDE desktop. So you do not need to port your existing applications to Motif or CDE to have them run on the Solaris CDE desktop.

This provides you with flexibility about when and under what circumstances you decide to port your application. For example, you may decide to wait until a major release of your product before porting your application to the Solaris CDE desktop.

Basic Integration

Basic application integration is a set of highly recommended tasks you should perform to integrate your application into the Solaris CDE desktop. These tasks do not require modification of the source code for your application. (Some types of print integration—enabling printing in your application—require slight code modification, but these are optional to basic integration.)

Basic integration does not involve extensive use of the desktop application program interface (API). Therefore, it does not provide other interaction with the desktop, such as drag-and-drop capabilities.
A lot can be done to integrate your application into the Solaris CDE desktop without modifying any code. You can:

- Define actions for your application
- Write a help volume and have it available from the top level of the Help Manager
- Integrate your application with the Front Panel and Application Manager
- Enable printing

The Solaris CDE desktop provides interoperability between your application and other desktop applications. You can add new services (see “Recommended Integration” on page 44 and “Optional Integration” on page 44) if you want to use them and are willing to modify your code.

See Common Desktop Environment: Programmer’s Guide for details on how to enable printing in your application, and for a list of the steps that comprise basic integration. See the “Registering an Application” chapter of Solaris Common Desktop Environment: Advanced User’s and System Administrator’s Guide for detailed instructions on how to implement the basic integration steps.

If You Decide to Port

If you decide that you definitely want to port, think of the process as an art and not as a science. There is no magic tool that will perform the port for you. There is no foolproof algorithm to follow that works every time. What you really need to do is learn Motif and CDE, and understand the CDE style guidelines. This takes time and patience.

Benefits of Porting

Benefits of porting to the CDE desktop include:

- Taking advantage of new features offered by CDE
- Providing easy portability on a wide variety of platforms
- Enabling better “ease of use” by ensuring that your application behaves according to the CDE style guidelines
• Providing interoperability with other Solaris CDE applications in areas where the Solaris CDE and OpenWindows environments differ, for example:
  • Window manager interaction
  • Drag and drop
  • Session management

**Integrating into the Solaris CDE Environment**

Recommended and optional integration require changes to your code to implement the functionality within these categories. Your application will be even more integrated with the desktop the more CDE functionality you adopt.

**Recommended Integration**

The Solaris CDE development environment contains components and guidelines so that your application will integrate well with other applications on the desktop:

• Help system
• ToolTalk messaging system
• Session Manager
• Drag and drop
• Internationalization
• Standard font names
• Error message guidelines
• User customization issues

**Optional Integration**

The following Solaris CDE components enable you to leverage services provided by the desktop for achieving specialized tasks:

• Solaris Motif control widgets
• Data typing
• Action invocation
• Workspace Manager
• Terminal widget
• Text editor widget
• Calendar API
• Desktop Korn shell
Start Small

If you plan to port your application to the Solaris CDE desktop, or if you want to practice porting, start with a small example and work your way up.

Convert and Clean Up

With small applications that have simple GUIs, you can practice porting by using a two-step process:

• Convert the GUI object-by-object from the OPEN LOOK user interface to Motif. (See “Use a Motif GUI Builder” below.)

• Clean up the resulting GUI so that it adheres to the CDE style guidelines. Take advantage of this opportunity to review the GUI for ease-of-use and customer-specific issues. You might decide to change the interface, even if the object-by-object conversion is style-guide compliant.

Chapter 7, “Porting Example: OPEN LOOK to Solaris Motif,” takes a simple OPEN LOOK application and illustrates this process.

Note – This is not the recommended way to port large, real-life applications.

Use a Motif GUI Builder

Use a Motif GUI builder such as Application Builder (App Builder) or SunSoft Visual WorkShop™ to build the new Motif GUI for the application. You need flexibility to experiment and make changes when you port using the two-step process described in “Convert and Clean Up.” If you manually code in a particular GUI, it is difficult and time consuming to make modifications. App Builder provides flexibility by enabling you to drag and drop objects to easily create prototype GUIs. It generally requires less time to use a GUI builder to lay out a new Motif interface than it does trying to port the GUI by hand.

In fact, whatever porting process you use and no matter how large your application, you should consider using a Motif GUI builder. These builders produce the GUI and application framework code, which frees your time to focus on application code.
Architectural Impact

Resist the urge to dive right in and start transforming your code to Solaris Motif. Begin the process of porting your application to Motif and CDE by examining your application's architecture.

The more architecture your application has, the more important it is to re-architect the application correctly up front. In these situations the complexity of the porting process increases dramatically if you use the “convert and clean up” strategy.

GUI and Internals

For programs in which important functions are insulated from the surrounding GUI, the impact of the difference in the OPEN LOOK user interface and Motif can be negligible. However, if the code is tightly linked to the user’s actions or relies on a specific OPEN LOOK feature, producing a Solaris Motif equivalent may be difficult.

If you can draw a line through your code modules and completely isolate those that constitute the user interface from those that make up the remainder of your application, then you can focus your migration efforts on the process of replacing the user interface modules with equivalent ones developed for Motif. Many application developers follow software development methods that require this kind of clean separation and, in some cases, even formally specify the program boundaries between user interface and application internals.

Alternatively, if your software is more monolithic and has application-specific abilities embedded within functions that also provide the user interface, then you may have to spend extra time separating the two types of functions, thereby complicating your migration. In an extreme case, you must choose between violating the style guide or redesigning part of the program.

The amount of time involved in taking full advantage of the Solaris CDE software significantly depends on how your application is laid out. Applications that are well designed are easier to port and to properly break down for maintenance and readability.
Static Versus Dynamic Layout

As mentioned previously, porting your application to Motif is not an object-for-object swap. Such swapping concentrates on the static aspects of your application user interface. Complex applications in particular contain many objects that manage the application infrastructure and make it work in dynamic situations. (Dynamic aspects of your application include, but are not limited to, resizing windows, localization, and font changes.) These manager widgets that handle the dynamic geometry in your application are different in the OPEN LOOK and Motif toolkits. Your application will not display the dynamism you want if you try an object-for-object swap of manager widgets. Introducing an appropriate design to handle the dynamic aspects of your application typically increases the complexity of its architecture.

XView does not provide much variety for dynamic layout. It primarily fixes objects at (x, y) positions, which can cause difficulties if an application font is changed or the application is localized. Motif and OLIT provide a variety of geometry manager widgets; however, they have significant differences.

<table>
<thead>
<tr>
<th>OLIT</th>
<th>Motif</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>BulletinBoard</td>
<td>XmBulletinBoard</td>
<td>Basically equivalent; provide static x,y pixel-based positioning for children</td>
</tr>
<tr>
<td>Caption</td>
<td>(none)</td>
<td>OLIT Caption widget provides a way to automatically place a label on one of the four sides of a control widget. To get this functionality in Motif, create a separate XmRowColumn widget that contains two children: the label and the control.</td>
</tr>
<tr>
<td>ControlArea</td>
<td>XmRowColumn</td>
<td>Both widgets provide a way to lay out children in rows and columns. The OLIT ControlArea widget supports aligning Caption widget children vertically by colon, which the Motif XmRowColumn widget does not. The Motif XmRowColumn widget enforces certain size policies on children (usually forces children in a particular row or column to be the same size), but the OLIT ControlArea widget does not.</td>
</tr>
<tr>
<td>FooterPanel</td>
<td>(none)</td>
<td>OLIT FooterPanel widget provides a way to lay out a window with a floating footer child at the bottom. The Motif XmMainWindow widget can be configured for this layout by setting the “message area child” to be a widget that can be used as a footer (such as an XmForm or XmRowColumn widget).</td>
</tr>
</tbody>
</table>
Study the Target Environment

The CDE desktop is quite different from the OpenWindows desktop, although it contains many of the same types of tools. The most obvious difference is that it is a Motif desktop. Read the “Architectural Overview” chapter of
Common Desktop Environment: Programmer’s Overview for a discussion of the end user and development environment architectural structure. Also read about:

- Motif: See “Motif 1.2 Documentation” on page 77 and “Motif Programming” on page 79 for a listing of Motif documentation.
- CDE Look and Feel: Refer to Common Desktop Environment: Style Guide and Certification Checklist for details. To be style-guide compliant, your application must pass the checklist at the end of the book.
- CDE Run-time and Development Environments: See “CDE Documentation” on page 76 for a listing of all CDE documentation that SunSoft provides. In addition, the desktop applications each have online help volumes.

**GUI Development Tools**

If you used a Motif GUI builder to create the GUI for your application, your migration to the Solaris CDE desktop will probably be easier. In most cases, the use of a builder implies that you have some degree of separation between user interface functions and application internals, the advantages of which were previously discussed.

Also, builders typically use generalized internal storage formats or are capable of generating interchange files, each of which may be post-processed to automate some of the conversion process. Contact your builder vendor to see what migration tools they are currently offering.

Other less tangible tools that you might have used and that could ease your transition include development approaches that produced functional requirements documents or high-level designs. These representations may describe your application in terms less specific to the OPEN LOOK user interface that are more amenable to being mapped to CDE and Solaris Motif than your source code.

**Use Transition Tools**

No one tool on the market will do everything you need for transitioning your application to the Solaris CDE desktop. Nonetheless, depending on different aspects of your application, you may find tools to solve some of your problems. These specialized tools can make the transition easier.
As you research the tools available to you, ask yourself if any are a good match for your application transition and what you are trying to do.

**Tools to Transition to Motif**

Many third-party tools are offered to transition to Motif. For example, Integrated Computer Solutions (ICS) offers two converters: one translates XView source code to GIL files and one translates GIL files to Motif source code.

SunSoft’s Devguide offers Motif Conversion Utilities as a way of helping customers make the transition. Devguide’s front end is still in the OPEN LOOK user interface, and it has the same OPEN LOOK palette, but you can use the Motif Conversion Utilities to transform GIL files into UIL files or Motif and C code. Use the Motif Conversion Utilities (\texttt{guil} and \texttt{gmf}) in the Solaris 2.4 Software Developer’s Kit to convert GIL files to UIL and Motif C code. UIL files can be imported into Motif GUI builders to generate Motif-based GUIs.

SunSoft also provides a Motif GUI builder called SunSoft Visual WorkShop.

Note that using transition tools for GUI migration results in a GUI that you will probably need to refine to be CDE style-guide compliant. You may need less time to re-layout the GUI if you use a GUI builder tool.

**Tools to Transition to the Solaris CDE Desktop**

If you used Devguide to create your application, you can use App Builder’s GIL-to-BIL converter to create BIL files, which is the format the App Builder uses. BIL file format is similar to GIL file format. However, BIL files contain CDE-specific information and produce a Solaris Motif GUI. The GIL-to-BIL converter makes some educated conversion guesses based on heuristics, which might not give you the result you want. For best results, take the BIL files that the converter produces, load them into App Builder, and modify the user interface as needed.

App Builder is a tool in the Solaris CDE environment that is very similar to Devguide, which is used in the OpenWindows environment. Transitioning to CDE in this manner solves a significant number of conversion problems. Because App Builder generates files for you, these files are easier to manipulate.
than C code you would have to write yourself. App Builder preserves application stubs files, so your application-specific code is unchanged. It also uses the same file-naming conventions as Devguide.

If you did not use Devguide, there are currently no third-party tools to use for converting OPEN LOOK applications to CDE. Try a Motif conversation tool such as is discussed in “Tools to Transition to Motif” above.

Use Existing Code

This section discusses the ways in which the Solaris CDE software provides code for you to either use or learn from to develop Solaris CDE applications.

GUI Builder Code

Use a Motif GUI builder such as App Builder or SunSoft Visual WorkShop to build a simple Solaris CDE application. Then generate code from it to see what the code looks like. This is a good way to learn how to use Solaris Motif and some of the CDE functionality.

The more features in App Builder you use, the more coverage you get in generated code of Solaris CDE features. Try App Builder to, for example, alter object attributes, create connections, and use the Applications Framework Editor. Then generate code and examine it. Cycle through this process to generate variations of code to look at and learn from.

Demo Code

The Solaris CDE development environment contains demo source code that can considerably ease your application porting tasks.

Each development environment component has a demo directory in /usr/dt/examples. The demo directory contains an example program that uses the component’s APIs. Read the demo code to learn how to incorporate the component behavior into your application. In some cases you can copy and paste code from the demo into your application.

The /usr/dt/examples/template directory contains a demo program that integrates most of the Solaris CDE components that comprise basic and recommended integration functionality. This template demo illustrates how to write a simple application that is well integrated with the Solaris CDE desktop.
Tips

Here are some tips about writing applications for the CDE desktop.

Floating Menus

To ensure that your application works properly on the CDE desktop, any functionality you put into floating menus should also be provided by some pulldown menu. This will enable your application to work with both two-button and three-button mouse devices.

Colormap Behavior

Colormap installation is handled differently under CDE than it was in the OpenWindows environment. This difference is most visible for applications that specify a list of subwindows that use colormaps other than the default colormap. This list of subwindows is specified in the `WM_COLORMAP_WINDOWS` property.

In the OpenWindows environment, applications need only to specify a list of subwindows in this property. As the user moves the pointer around the screen, the OpenWindows window manager (`olwm`) installs the appropriate colormap for whatever window is under the pointer.

The CDE window manager, `dtwm`, does not provide this behavior. Applications that relied on `olwm`’s pointer-based colormap installation will likely not display in their proper colors when run under CDE. There are several things that you can do to avoid this problem:

- Avoid using the `WM_COLORMAP_WINDOWS` property entirely, and update the colormap attribute of the top-level window (the window of the shell widget) with whatever colormap is appropriate. This colormap will be installed whenever the window is given the input focus.

- The `WM_COLORMAP_WINDOWS` property is an ordered list of windows, and typically only the first window in this list will have its colormap installed and will appear in its proper colors. The other subwindows will most likely appear with incorrect colors. If it is important for a particular subwindow to appear with its correct colors, it should be placed first in the list.
• If the ID of the top-level window does not appear in the list, it is implicitly assumed to appear first. To get a subwindow to display with its correct colors, the ID of the top-level window should appear in the list somewhere after the ID of the subwindow.

• Applications can update the WM_COLORMAP_WINDOWS property at any time. If the application's state changes such that a different subwindow should now have its colormap installed, the application should update the property so that the new subwindow appears first.

The user can also modify the key bindings of dtwm to bind the f.next_cmap and f.prev_cmap functions to keyboard keys. These functions will step forward and backward through the WM_COLORMAP_WINDOWS list and install a different colormap each time the user presses the appropriate keys.

Summary: Things to Keep in Mind

Here is a list of things to keep in mind as you think about porting your application to the Solaris CDE desktop:

• OPEN LOOK to Motif migration is a complex and wide-ranging issue

  It generally does not amount to an object-for-object swap. Do you really need to port? If so, think of it as an art and not as a science.

• What is your schedule?

  When must you ship? What resources do you have available to you? Can you tie the port in with the next major release?

• How did you build your application?

  Did you use a builder? Were any other tools involved in producing your application? If so, go to your vendor and ask for CDE support.

• Is your application GUI separate from internals?

  Did you use C++ objects to encapsulate the GUI? If so it will be easier to port your application.

• Are you starting from XView or OLIT?

  OLIT applications are generally easier to port because they rely on the Xt intrinsics, as does Motif.
Are there any customer issues?

Do you have to be concerned about interoperability with other systems? Are there transition and training issues for the customer? Is a mixed desktop acceptable for now?
Porting Example: OPEN LOOK to Solaris Motif

This chapter presents an example of porting an OPEN LOOK application with a simple graphical user interface (GUI) to Solaris Motif. It illustrates the two-step process of porting: first translating the OPEN LOOK user interface objects one-by-one to Motif objects, then cleaning up the interface and making sure it conforms to the CDE style guide.

Of course, your goal in porting from the OPEN LOOK user interface to Solaris Motif should be to convert the GUI and clean up at the same time. The more familiar you become with the CDE style guide, the easier this will be. Also, as you learn more about Motif, learning the correlation between OPEN LOOK objects and Motif widgets will become easier.

When porting your application, take the opportunity to examine its user interface. Think about whether it could be streamlined or made more user-friendly. In going from the OPEN LOOK user interface to Motif, the application’s look will change anyway. This is a good time to re-examine design decisions you made in the past.
OpenWindows 3.4 Snapshot Application

Figure 7-1 is an illustration of the OpenWindows 3.4 Snapshot application. It is running on the Solaris CDE desktop using the Motif Window Manager, so it has a Motif title bar.

The Snapshot GUI is fairly simple. It contains:

- Load..., Save..., Snap, and View... buttons
- Print menu button
- Snap Type and Snap Delay exclusive settings
- Beep and Hide check box settings
- Drop target

Figure 7-1  OpenWindows 3.4 Snapshot Application GUI
Convert

Using App Builder, the Snapshot GUI translates object-for-object into the GUI shown in Figure 7-2:

![Figure 7-2 Motif Port of Snapshot GUI (Direct Translation)](image)

You can see that the pieces of the interface and the general layout are very similar to the OPEN LOOK version. The buttons remain, except that they are square now instead of round. The check boxes look the same. The OPEN LOOK exclusive settings have changed to Motif radio buttons (which also offer mutually exclusive choices). A small text field with no label replaces the drop target.
Clean Up

If you want, you can consider yourself finished with this application port. No functionality has been lost, and the GUI now appears in Motif. However, you should ask yourself two questions:

• Is the resulting application style-guide compliant?
• Can the GUI be redesigned to make the application more user friendly?

Consider CDE Style Guidelines

Common Desktop Environment: Style Guide and Certification Checklist highly recommends placing menu bars in applications. In addition, it considers File, Options, and Help menus as standard, to be placed in order from left to right. (Other menus are also considered standard but do not apply to the Snapshot application.)

The cleaned-up version places the Load, Save, and Print buttons under the File menu. These are typical file operations. “Beep During Countdown” and “Hide Window During Capture” are options that users have available to them, and are therefore put under the Options menu. This design decision also makes the interface less cluttered, since the text for these check boxes takes up a lot of screen space. A Help menu is added to comply with the style guidelines.

Common Desktop Environment: Style Guide and Certification Checklist calls for a footer message at the bottom of an application whenever status is displayed there. This is added to the Snapshot GUI.

Motif does not support a drop site object. CDE supports a drag source object, which appears in the final GUI as a labelled camera icon. If you want drop support, the CDE style guidelines indicate that you must provide code to enable objects to be dropped anywhere in the application’s main window.

Finally, the Snap button at the bottom is highlighted, indicating that it is the default value (between Snap and View) if the user presses Return instead of pressing a button.
Other Design Considerations

The radio buttons take up a lot of screen space in the Snapshot GUI. CDE provides a widget called a `DtComboBox` that takes up less screen space and provides the same functionality. The Snap Type and Snap Delay radio buttons are replaced by `DtComboBox` widgets. The most typically used values appear as `DtComboBox` defaults.

You cannot use the `DtComboBox` widget if you are developing your application for the OpenWindows desktop. This widget is part of the CDE development environment, not the OpenWindows development environment. Even if you do have access to the ComboBox, however, you may want to retain the radio boxes, depending on issues such as ergonomics, customer needs, and consistency.

![Motif Port of Snapshot GUI (Final Port)](image)

Figure 7-3  Motif Port of Snapshot GUI (Final Port)
This appendix presents all the user interactions that have changed from the OPEN LOOK style to the CDE style. If a user interaction is not mentioned, the OPEN LOOK and CDE styles are the same.

Use this information to give your CDE application the correct user model.

Note – In this appendix, CDE Style Guide refers to Common Desktop Environment: Style Guide and Certification Checklist.

<table>
<thead>
<tr>
<th>Category</th>
<th>Topic</th>
<th>OPEN LOOK:</th>
<th>CDE:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Desktop</td>
<td>Multiple desktops</td>
<td>One main workspace or virtual, multiple screen support (OLVWM).</td>
<td>Multiple workspaces are accessible from the Front Panel; users can add, remove, and navigate between workspaces.</td>
</tr>
<tr>
<td></td>
<td>Action feedback</td>
<td>No indicator to provide feedback when application is launched.</td>
<td>Indicator light on Front Panel, which initially blinks when application is first launched and when other actions occur.</td>
</tr>
<tr>
<td></td>
<td>Application access</td>
<td>Applications (and utilities) are accessible from Programs menu off Workspace menu. Programs menu customizable via GUI.</td>
<td>Applications accessible from the Front Panel, the Application Manager, the Personal Applications subpanel, as well as the Programs submenu of the Workspace menu. No GUI for customizing Programs menu.</td>
</tr>
</tbody>
</table>
### Table A-1  User Interaction Changes

<table>
<thead>
<tr>
<th>Category</th>
<th>Topic</th>
<th>OPEN LOOK:</th>
<th>CDE:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drag and drop to desktop</td>
<td>When icon from File Manager dropped on desktop, the application associated with the icon is launched or executed.</td>
<td>Dropping icon from File Manager onto desktop does not launch or execute: it creates a reference to the icon on the desktop (the original icon still appears in the File Manager).</td>
<td></td>
</tr>
<tr>
<td>Fast help information</td>
<td>Uses Magnify Help; has link to More Help window for further information.</td>
<td>Uses On Item Help to go to item in Help handbook.</td>
<td></td>
</tr>
<tr>
<td>Application Help</td>
<td>Available by pressing keyboard Help key when in application.</td>
<td>Help available from most menu bars (located at the far right of the menu bar) and dialog boxes; also available by pressing the keyboard Help key when in application.</td>
<td></td>
</tr>
<tr>
<td>Properties</td>
<td>Multiple terms used to indicate properties</td>
<td>Uses the term Properties (and sometimes, Settings), generally found under Edit menu.</td>
<td>Uses the terms Options and Properties. Options refers to application-specific characteristics and is generally found under the File or Options menu. Properties is used to set object-specific characteristics and is generally found under the Edit menu.</td>
</tr>
<tr>
<td>Global desktop options</td>
<td>Set from the Workspace menu.</td>
<td>Set from the Style Manager application.</td>
<td></td>
</tr>
<tr>
<td>Windows</td>
<td>Window titles</td>
<td>Generally follows the form: &quot;File Manager V3.4: /home/username/Project_Folder&quot;.</td>
<td>Generally follows the form: &quot;File Manager - Project_Folder&quot;. Version numbers not included in title (version numbers can be included in the application’s About box). Title format specified in CDE Style Guide (see pages 92-93).</td>
</tr>
<tr>
<td></td>
<td>Move a window</td>
<td>Click anywhere on window frame (except window corners) and drag to move the window.</td>
<td>Click window title area and drag to move the window.</td>
</tr>
</tbody>
</table>
### Table A-1  User Interaction Changes

<table>
<thead>
<tr>
<th>Category</th>
<th>Topic</th>
<th>OPEN LOOK:</th>
<th>CDE:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand a window</td>
<td>Double-click the frame to expand window: window expands vertically. The window position is retained.</td>
<td>Click the maximize button to expand the entire window. The default is maximize equals full screen. To change the maximize direction to vertical only, use the <code>Dtwm*maximumClientSize:vertical</code> resource.</td>
<td></td>
</tr>
<tr>
<td>Resize a window</td>
<td>Click any corner of the window and drag to resize.</td>
<td>Click any part of the window frame (including the corners) and drag to resize the window. A resize outline box will display and update the window’s size during the resize operation.</td>
<td></td>
</tr>
<tr>
<td>Raise a window</td>
<td>Click either the title bar or the window frame.</td>
<td>Click anywhere in window.</td>
<td></td>
</tr>
<tr>
<td>Remove or dismiss window</td>
<td>Click pushpin to remove (dismiss) windows.</td>
<td>Choose Close from the Window menu or press Alt + F4. OPEN LOOK applications run in CDE do not have pushpins, and are dismissed by the above actions.</td>
<td></td>
</tr>
<tr>
<td>Closing a window to an icon (iconify)</td>
<td>Choose the Close command from the Window menu to iconify. [Window menu is the boxed arrow in upper left corner of window.] Since Close is the default choice in the Window menu, a single-click on the Window menu icon will close the window (if default action in Properties is set to Left Mouse Press: Selects Default Item).</td>
<td>Choose Minimize from the Window menu or click the minimize button at the upper right corner of the window frame.</td>
<td></td>
</tr>
<tr>
<td>Quitting (terminating) an application</td>
<td>Choose the Quit (or Exit) command in Window menu.</td>
<td>Choose Close or Exit command in either the Window or File menu or double-click the Window menu icon to exit application.</td>
<td></td>
</tr>
<tr>
<td>Menus</td>
<td>Menu layout type</td>
<td>Uses menu buttons.</td>
<td>Uses menu bar.</td>
</tr>
</tbody>
</table>
### Menu layout

- **File-View-Edit-Properties**
  - **File-Edit-View-Options-Help**

- **Keep menu on desktop**
  - Click a pushpin in the menu.
  - Has tear-off menus.

- **Default action from menu**
  - In Workspace Properties, can configure Left Mouse Press to represent Selects Default Item.
  - In this mode, a single click on the menu button chooses the default menu item.
  - The default item is shown in the menu surrounded by a ring.

- **Quick menu access**
  - Abbreviated pop-up menu shows available commands. Displayed by clicking mouse button 3 (MENU).

- **Accessing menus from the keyboard**

<table>
<thead>
<tr>
<th>Category</th>
<th>Topic</th>
<th>OPEN LOOK:</th>
<th>CDE:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu layout</strong> (standard)</td>
<td>File-View-Edit-Properties</td>
<td>File-Edit-View-Options-Help</td>
<td></td>
</tr>
<tr>
<td>Keep menu on desktop</td>
<td>Click a pushpin in the menu.</td>
<td>Has tear-off menus.</td>
<td></td>
</tr>
<tr>
<td>Default action from menu</td>
<td>In Workspace Properties, can configure Left Mouse Press to represent Selects Default Item. In this mode, a single click on the menu button chooses the default menu item. The default item is shown in the menu surrounded by a ring.</td>
<td>There is no default menu item.</td>
<td></td>
</tr>
<tr>
<td>Quick menu access</td>
<td>Abbreviated pop-up menu shows available commands. Displayed by clicking mouse button 3 (MENU).</td>
<td>Same.</td>
<td></td>
</tr>
<tr>
<td>Accessing menus from the keyboard</td>
<td>No keyboard mnemonics used to access menus.</td>
<td>Can use keyboard to display and choose from menu. The menu’s mnemonic is shown by the underlined character in the menu’s name (this may not be the first letter of the menu name). The menu is displayed by holding down Alt + the underlined letter. To access a particular menu option, press the key for the item’s mnemonic, or press the down arrow to move to the item and press Return or Spacebar.</td>
<td></td>
</tr>
</tbody>
</table>

### Dialog Boxes

| Dialog Boxes | File selection (via typing file name or choosing from scrolling list) | Generally offers command windows (for example, New, Load, Load/Save) that enable users to type or select a file. | Offers a standard Common Desktop Environment file selection dialog box that can be modified to accommodate application-specific file navigation/selection options. See CDE Style Guide for examples and guidelines. |
| Print dialog box | Print dialog boxes vary by application. | Offers a common Print dialog box that can be modified to accommodate application-specific print options. See pages 116-122 of CDE Style Guide for examples and guidelines. |
### Table A-1  User Interaction Changes

<table>
<thead>
<tr>
<th>Category</th>
<th>Topic</th>
<th>OPEN LOOK:</th>
<th>CDE:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Remove or dismiss dialog box</td>
<td>Property windows are a form of dialog box that use both a pushpin and buttons. The Apply button applies changes and dismisses an unpinned Property window but not a pinned one. To dismiss a pinned window, click the pushpin.</td>
<td>Button actions determine whether dialog box remains up after action taken: Cancel dismisses the dialog box without performing any actions not yet applied, Close dismisses the dialog box, OK applies changes and dismisses the dialog box, and Apply applies changes and does not dismiss the dialog box. No pushpins are used when OPEN LOOK applications are run in CDE. See Chapter 7 of CDE Style Guide, “Common Dialogs,” for more information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Controls for choosing related items/values</td>
<td>Uses the abbreviated menu button, which displays the current choice without displaying the entire menu. Can either choose a value from the button menu or type a value in a text field and press Return to validate the value.</td>
<td>Uses a ComboBox, a Command Box, or a SpinBox to perform the same functions as the abbreviated menu button types. ComboBox uses a scrollable list box, CommandBox uses a prompt for text input and a list component, and SpinBox presents values as a ring of items that wrap. See the “Controls, Groups, and Models” section of CDE Style Guide (starting on page 234) for descriptions and guidelines.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Toolbars</td>
<td>Does not use toolbars.</td>
<td>Uses toolbars.</td>
</tr>
<tr>
<td></td>
<td>Button shape</td>
<td>Rounded buttons.</td>
<td>Square buttons.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Default mouse button functions</td>
<td>Mouse button 1 = Select Mouse button 2 = Adjust Mouse button 3 = Menu</td>
<td>Mouse button 1 = Select Mouse button 2 = Transfer (can be changed to Adjust through Style Manager) Mouse button 3 = Menu</td>
</tr>
</tbody>
</table>

---

*User Interaction Changes*

65
## Extend selection

On a 3-button mouse, use mouse button 2 (also called the ADJUST button) to do an extended selection. Click mouse button 1 at the beginning of the text that you want to select, move pointer to end of desired text, and click mouse button 2; text is highlighted.

To do an extend selection, use Shift key + mouse button 1, or change the behavior of mouse button 2 from Transfer (the default setting) to Adjust through Style Manager.

## Displaying menus

Click mouse button 3 on a menu button to display the menu.

Click a menu bar entry with either mouse button 1 or mouse button 3 to display the menu.

## Opening icons: shortcut

Double-click icons to open.

Double-click icons to open. Single- or double-click Front Panel controls, and single-click Style Manager controls, to launch the related application.

## Quick Cut

To move text to insertion point, hold down the Cut key, select text (a line is drawn through selected text), and release the Cut key. When key is released, text moves to the insertion point.

To move text to insertion point, hold down Alt + Shift + mouse button 2 (Transfer), and select text (a line is drawn under selected text). When combination is released, text moves to the insertion point.

## Quick Paste

To copy to the insertion point, hold down the Paste key, select text (a line is drawn under selected text), and release the Paste key.

To copy to the insertion point, hold down Alt + mouse button 2 (Transfer), and select text (a line is drawn under selected text). When combination is released, text is copied to the insertion point. (This will also work with Alt + Control + mouse button 2.)

## Drag and drop (direct manipulation)

Uses one set of drag-and-drop methods and visual feedback.

The basics of drag and drop are similar to OPEN LOOK, but the specifics are different. See Chapter 3 of CDE Style Guide, “Drag and Drop,” for details of drag-and-drop operations, performance guidelines, feedback, and graphics specific to CDE.

<table>
<thead>
<tr>
<th>Category</th>
<th>Topic</th>
<th>OPEN LOOK:</th>
<th>CDE:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extend selection</td>
<td>On a 3-button mouse, use mouse button 2</td>
<td>To do an extend selection, use Shift key + mouse button 1, or change the</td>
<td>To do an extend selection, use Shift key + mouse button 1, or change the behavior of mouse button 2 from Transfer (the default setting) to Adjust through Style Manager.</td>
</tr>
<tr>
<td></td>
<td>(also called the ADJUST button) to do an</td>
<td>behavior of mouse button 2 from Transfer (the default setting) to Adjust</td>
<td></td>
</tr>
<tr>
<td></td>
<td>extended selection. Click mouse button 1</td>
<td>through Style Manager.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>at the beginning of the text that you</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>want to select, move pointer to end of</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>desired text, and click mouse button 2;</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>text is highlighted.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Displaying menus</td>
<td>Click mouse button 3 on a menu button to</td>
<td>Click a menu bar entry with either mouse button 1 or mouse button 3 to</td>
<td>Double-click icons to open. Single- or double-click Front Panel</td>
</tr>
<tr>
<td></td>
<td>display the menu.</td>
<td>display the menu.</td>
<td>controls, and single-click Style Manager controls, to launch the</td>
</tr>
<tr>
<td>Opening icons: shortcut</td>
<td>Double-click icons to open.</td>
<td></td>
<td>related application.</td>
</tr>
<tr>
<td>Quick Cut</td>
<td>To move text to insertion point, hold down</td>
<td>To move text to insertion point, hold down Alt + Shift + mouse button 2</td>
<td>To move text to insertion point, hold down Alt + Shift + mouse button 2</td>
</tr>
<tr>
<td></td>
<td>the Cut key, select text (a line is drawn</td>
<td>(Transfer), and select text (a line is drawn under selected text). When</td>
<td>(Transfer), and select text (a line is drawn under selected text).</td>
</tr>
<tr>
<td></td>
<td>through selected text), and release the</td>
<td>combination is released, text moves to the insertion point.</td>
<td>When combination is released, text moves to the insertion point.</td>
</tr>
<tr>
<td></td>
<td>Cut key. When key is released, text</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>moves to the insertion point.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quick Paste</td>
<td>To copy to the insertion point, hold down</td>
<td>To copy to the insertion point, hold down Alt + mouse button 2 (Transfer),</td>
<td>To copy to the insertion point, hold down Alt + mouse button 2 (</td>
</tr>
<tr>
<td></td>
<td>the Paste key, select text (a line is</td>
<td>and select text (a line is drawn under selected text). When combination</td>
<td>Transfer), and select text (a line is drawn under selected text).</td>
</tr>
<tr>
<td></td>
<td>drawn under selected text), and release the</td>
<td>combination is released, text is copied to the insertion point. (This</td>
<td>When combination is released, text is copied to the insertion point.</td>
</tr>
<tr>
<td></td>
<td>Paste key.</td>
<td>will also work with Alt + Control + mouse button 2.)</td>
<td></td>
</tr>
</tbody>
</table>

### Table A-1  User Interaction Changes
A

---

**Table A-1  User Interaction Changes**

<table>
<thead>
<tr>
<th>Category</th>
<th>Topic</th>
<th>OPEN LOOK:</th>
<th>CDE:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drop onto minimized icons</td>
<td>Can drop onto minimized icons on desktop; drop will result in appropriate action.</td>
<td>Not supported. Can drop onto Front Panel controls (for example, Printer, Calendar Manager, Trash, Text Editor, Mailer).</td>
<td></td>
</tr>
<tr>
<td>Drag and drop multiple messages from Mail application to File Manager</td>
<td>Creates one mailfile icon per message in File Manager.</td>
<td>Creates one mailbox that contains all the selected messages.</td>
<td></td>
</tr>
<tr>
<td>Drag mail messages to another mailbox window</td>
<td>Not available.</td>
<td>Moves the selected messages to the destination mailbox.</td>
<td></td>
</tr>
<tr>
<td>Drop selected icon into text window</td>
<td>Text appears at drop point.</td>
<td>Text appears at insertion point (same as choosing Include from the File menu).</td>
<td></td>
</tr>
<tr>
<td>Drop zone (target)</td>
<td>Drop zone (target) is a small rectangle typically located in top right of application's control area.</td>
<td>No specific drop zone graphic is used; any editable control can serve as a drop zone. User gets feedback on validity of drop zone.</td>
<td></td>
</tr>
<tr>
<td>Sourcing drags</td>
<td>Uses drag-and-drop source indicator graphic.</td>
<td>Several versions of source indicators are used, representing the type of selection (single or multiple) and the type of object selected. The drag icons are dynamically composed and contain the source indicator information.</td>
<td></td>
</tr>
</tbody>
</table>

---

User Interaction Changes 67
### Table A-1  User Interaction Changes

<table>
<thead>
<tr>
<th>Category</th>
<th>Topic</th>
<th>OPEN LOOK:</th>
<th>CDE:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyboard</td>
<td>Keyboard accelerators and engraving</td>
<td>Uses Meta key in combination with accelerator key. Standard examples: Meta + z = Undo, Meta + c = Copy, Meta + v = Paste, Meta + x = Cut. Uses default set of key bindings and enables customization of key bindings (for example, EMACS).</td>
<td>Uses Control key in combination with accelerator key. Standard examples: Control + z = Undo, Control + c = Copy, Control + v = Paste, Control + x = Cut. Default key bindings sometimes differ from OPEN LOOK key bindings (see Appendix A of CDE Style Guide for key engravings). Customization is also available (see Chapter 10 of CDE User’s Guide for customization information).</td>
</tr>
<tr>
<td>Sun Special keys</td>
<td>supported in OPEN LOOK.</td>
<td>supported in solaris CDE.</td>
<td>supported in Solaris CDE.</td>
</tr>
<tr>
<td>Deleting characters</td>
<td>Can use either Backspace or Delete key.</td>
<td></td>
<td>The Backspace key deletes characters to the left of the cursor; the Delete key deletes characters to the right of the cursor.</td>
</tr>
</tbody>
</table>
Internationalization and CDE

This is a guide for software developers writing internationalized Solaris CDE applications. It presents the differences between OpenWindows and CDE internationalization. Any steps that must be performed to internationalize a Solaris CDE application that are not mentioned in this appendix remain unchanged from the OpenWindows guidelines. For general information on CDE and internationalization, see Common Desktop Environment: Internationalization Programmer’s Guide.

| Ensure Correct CDE NLS Environment                  | 70 |
| Message Catalog Functions                           | 70 |
| Locale Announcement                                  | 71 |
| Character Strings and XmStrings                      | 71 |
| Include app-defaults File                            | 71 |
| Localize Motif Resources                             | 72 |
| Deliver Message Catalog                              | 72 |
| Fonts                                                | 73 |
| Internationalizing Shell Scripts                     | 73 |

Solaris CDE supports all locales that Solaris 2.6 supports.
This appendix assumes familiarity with Xt and Motif programming.

Ensure Correct CDE NLS Environment

You must make sure that the NLSPATH environment variable is set properly. This ensures that your application will find message catalogs.

If your application calls DtInitialize(), then NLSPATH is set to the CDE default location for finding message catalogs. The default location is /<CDE_INSTALLATION>/lib/nls/msg/<locale>/<application>.cat; for example, /usr/dt/lib/nls/msg/ja/dtcm.cat.

DtInitialize() sets other variables and performs other tasks. Consult its manpage to determine whether you need this function. DtInitialize() is in libDtSvc. If your application does not already link to this library, you may not want to invoke DtInitialize() just to set NLSPATH.

If your application does not call DtInitialize(), you must set NLSPATH to ensure that your application can find message catalogs.

If your application installs or expects message files to be in a location other than the default location, you should append that location to NLSPATH.

Note – Other CDE applications may not be able to find their message catalogs if you reset NLSPATH entirely. It is better to append to NLSPATH if your message file location differs from the default location.

Message Catalog Functions

To be portable to other XPG4 UNIX platforms, Solaris CDE applications must use the catopen(), catclose(), and catgets() family of XPG4 messaging functions (instead of gettext() and so on). See the man pages for information on how to use these functions.

Also, if the system on which you are writing your application does not define NL_CAT_LOCALE in a header file, you must define it in your application. This ensures that the application is portable to other UNIX XPG4-compliant platforms.
Locale Announcement

So that your application knows what locale it is running in, use:

- XtSetLanguageProc()—If your application is Motif/Xt GUI-based
- setlocale()—If your application is not GUI-based

Character Strings and XmStrings

This section describes how to convert between character strings and XmStrings.

To Convert from Character String to XmString

In Motif, you must make an explicit call to convert a string to XmString, an internal representation of the string. If you internationalize your application, use XmStringCreateLocalized() to perform this conversion.

In Solaris Motif—unlike in Motif 1.2.3—XmStringCreateLocalized() recognizes \n as a line separator, so a string can have multiple lines.

To Convert from XmString to Character String

To convert from XmString to a character string, you must traverse the compound string and retrieve each segment individually. See section 19.3.3 of the Motif Programming Manual, Volume 6A, which contains a code sample that performs this conversion.

Do not use XmStringGetLtoR() to convert from XmString to a character string. This function assumes the text is oriented left-to-right.

Include app-defaults File

If your application uses resources, make sure to include an app-defaults file. Refer to the X Toolkit Intrinsics Programming Manual (Volume 4, Section 2.3.3) for details on setting up an app-defaults file.
Localize Motif Resources

Localize any Motif resource that represents something that must be customized for a particular locale by putting the resource in your `app-defaults` file. These include, but are not limited to:

- XmNmnemonic
- XmNfontList
- XmNcolumns
- XmNinputMethod
- XmNpreeditType

Deliver Message Catalog

Every SVR4 UNIX platform contains the `gencat` utility. Run `gencat` on the translated message catalog file to produce a binary form of the message catalog. The resulting file is a formatted message database.

CDE and gencat

Each platform has its own implementation of `gencat`. Follow these rules for message catalogs to ensure that each message catalog’s format does not cause different `gencat` utilities to break:

1. Use a `$quote` directive if you have trailing spaces (see the `gencat man page`).
2. Do not put more than one space between the message id and the message string.
3. Insert a space between `$` and the comments.
4. Message IDs need to be sorted in ascending order.

.msg Files

A `.msg` file is a message catalog containing translatable text that appears in your application code. It is the file that you give to a translator for translation. See the `gencat man page for its format. Use `gencat` to turn a translated message catalog to a message database.
.cat Files

A .cat file is a message catalog that results when you run gencat on a .msg file. This is a binary file.

Fonts

In the OpenWindows environment, font alias names differ depending on the application locale. In Solaris CDE, the font alias names are independent of locale. Refer to Common Desktop Environment: Internationalization Programmer’s Guide or Common Desktop Environment: Programmer’s Guide for information on CDE font names.

Internationalizing Shell Scripts

The dt.dspmsg utility is useful for internationalizing shell scripts. The dt.dspmsg command displays a selected message from a message catalog. See the dt.dspmsg man page for details.
This appendix lists books and articles on issues related to OPEN LOOK, Motif, and Solaris CDE application development. The books are available through Sun Express or through your local bookstore.

<table>
<thead>
<tr>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDE Documentation</td>
<td>76</td>
</tr>
<tr>
<td>ToolTalk Documentation</td>
<td>76</td>
</tr>
<tr>
<td>Motif 1.2 Documentation</td>
<td>77</td>
</tr>
<tr>
<td>Graphical User Interfaces</td>
<td>78</td>
</tr>
<tr>
<td>Motif Programming</td>
<td>79</td>
</tr>
<tr>
<td>OPEN LOOK Programming</td>
<td>79</td>
</tr>
<tr>
<td>Xi/XLib Programming</td>
<td>79</td>
</tr>
</tbody>
</table>
CDE Documentation

The Common Desktop Environment documentation set contains documents that will help you in your transition to Solaris CDE. These books will be published soon by Addison-Wesley.

Development Environment

- Common Desktop Environment: Programmer’s Overview
- Common Desktop Environment: Style Guide and Certification Checklist
- Common Desktop Environment: Application Builder User’s Guide
- Common Desktop Environment: Programmer’s Guide
- Common Desktop Environment: Help System Author’s and Programmer’s Guide
- Common Desktop Environment: ToolTalk Messaging Overview
- Common Desktop Environment: Internationalization Programmer’s Guide
- Common Desktop Environment: Desktop KornShell User’s Guide
- Common Desktop Environment: Product Glossary

Online man pages are available for all development environment components.

Run-time Environment

- Solaris Common Desktop Environment: User’s Guide
- Solaris Common Desktop Environment: Advanced User’s and System Administrator’s Guide
- Solaris Common Desktop Environment: User’s Transition Guide
- Introduction to Solaris Common Desktop Environment

Online help volumes are available for most of the run-time environment components.

ToolTalk Documentation

The Solaris 2.5 Software Developer AnswerBook set contains:

- ToolTalk Reference Manual
- ToolTalk User’s Guide

**Motif 1.2 Documentation**

The documentation listed in this section describes Motif 1.2 interfaces. Motif 1.2.5 is a patch release of 1.2 and the same specifications apply. You can purchase these books at your local bookstore.

  
  Describes the Motif Application Environment Specification. Information on these specifications can also be found in the *Motif 1.2 Programmer’s Reference Manual*.

- *Motif 1.2 User’s Guide 801-5363-10*

  This user’s guide describes how to interact with Motif-based applications, including how to use and customize the Motif Window Manager, how to use the Motif widgets, and how to customize your interaction with Motif applications.


  This programmer’s reference manual provides reference information for the Motif commands and functions in UNIX-style manual pages. The reference information covers the toolkit (library functions, widget documentation, and resources), the window manager, UI language commands, and the library functions.

- *Motif 1.2 Programmer’s Guide 801-5365-10*

  This programmer’s guide describes how to use the Motif API to create Motif applications. Also describes the architecture of the Motif widget set and the features of the toolkit. It is useful for new Motif programmers. A number of the example programs from this volume is available in source form in the share/src directory.
• Motif 1.2 Style Guide 801-5366-10

This style guide provides a description of the framework of behavior specifications (the Motif appearance) to guide developers in the design and implementation of products with Motif-style UI. The guide is split into sections applicable to four audiences: application designers, widget designers, user interface system designers, and window manager designers. The appendixes describe how the Motif widgets correspond to the components in the guide and provide a checklist of requirements for OSF/Motif application-level certification.

Graphical User Interfaces


**Motif Programming**


**OPEN LOOK Programming**


**Xt/XLib Programming**


## Index

### A
- actions, CDE, 22
- app-defaults, 71
- Application Builder (App Builder), 20, 45, 50, 51, 57
- architecture, OPEN LOOK versus Motif, 32

### B
- basic integration, 42
- BIL files, 50

### C
- callbacks, 31, 32
- CascadeButton, 10
- .cat file, 73
- catclose(), 70
- catgets(), 70
- CDE
  - features exclusive to, 19 to 20
  - features in common with OpenWindows, 20 to 25
- CDE applications,
  - internationalization, 69, 73
- CDE documentation, 76
- CDE examples, source code location, 51
- CDE widgets
  - compatibility with Motif 2.0, 14
  - demo programs, 14
  - DtComboBox, 13
  - DtMenuButton, 13
  - DtSpinBox, 13
  - library and header files, 14
- classing engine, 22
- color, 25
- ComboBox, 59
- compiling
  - Motif applications, 8
  - controls, window, 29

### D
- data typing, CDE, 22
- DATA_ATTRIBUTES table, 22
- DATA_CRITERIA table, 22
- DEC VT220, 15, 38
- demo programs, 14, 15
- Desktop Korn shell (dtksh), 19
- development tools, GUI, 49
- Devguide, 20, 50, 51
- documentation
  - CDE, 76
GUI, 78
Motif 1.2.3, 77
Motif programming, 79
OPEN LOOK programming, 79
ToolTalk, 76
Xt/XLib programming, 79

DPS, 19
drag and drop, 21
DropTarget, 40
DtComboBox, 12, 13, 14, 38
dtksh, 19
DtMenuButton, 12, 13, 14, 38
DtSpinBox, 12, 13, 14, 38
DtTerm, 38

E
existing applications
running in CDE environment, 3
running in Solaris environment, 2

F
FileSelectionBox, 39
Flat Widget, 40
fonts, 24, 73
Footer Panel, 40

G
gencat, 72
ggettext(), 70
GIL files, 50
GIL-to-BIL converter, 20, 50
gmf, 50
GUI
application builders, 20
development tools, 49
documentation, 78
guil, 50

H
help system, 20, 22 to 24

I
integration
basic, 42
into CDE environment, 44
optional, 44
recommended, 44
internationalization, 20, 24
CDE applications, 69 to 73
IXI 1.2.2 Motif, 11

L
levels of integration
basic, 42
optional, 44
recommended, 44
libDtTerm, 15
libDtWidget, 12, 14, 39
libMrm, 10
libUil, 10
libXm, 10
linking Motif applications, 8

M
manager widgets, 47
Manager, Workspace, 20
menu button widget (DtMenuButton), 13
menus, tear-off, 29
message catalog, delivery, 72
message sets, 21
Microsoft Windows, 10
migrating to Solaris Motif, 42
model, for XView and Motif programming, 32
Motif, 58
applications and color, 25
buttons, 30
conversion utilities, 50
enhancements to existing functionality, 10
GUI builders, 45, 49, 51
IXI 1.2.2, 11
programming documentation, 79
resources, localization, 72
shared library policy, 8
Solaris, 9 to 11
summary of Solaris toolkits, 1
transition to, 50
UIL library, 10
widgets and XView objects, 33
Window Manager (mwm), 56
Motif 1.2, 14
Motif 1.2.3 documentation, 77
Motif 2.0, 14
Motif application development
OpenWindows environment, 3
Solaris CDE environment, 4
Motif code, produced from GIL files, 20
.mouse file, 72

NL_CAT_LOCALE, 70
NLS environment, 70
NLSPATH, 70

objects, types common to XView and Motif, 33
OLIT, 3, 20, 28, 32, 53
OLIT libraries
routines only in, 35
routines only in CDE Motif, 36
versus CDE Motif libraries, 35 to 39
widgets, 36
widgets exclusive to Motif, 38
OPEN LOOK, 12, 28, 29
optional integration, 44

porting
architectural impact, 46
basic integration, 42
benefits, 43
CDE Motif, to, 41 to 54
elements of, 42
example, 55
small applications, 45
summary, 53
two-step process, 55

radio buttons, 59
recommended integration, 44
RubberTile, 40
.run-time terminal, dtterm, 15

secondary text selection, 29
Session Manager, 20
.setlocale(), 71
Snap button, 58
Solaris
Motif run-time and developer support, 7
Motif toolkits, summary, 1
Solaris Motif
enhancements to Motif 1.2.5, 10
libraries, 10 to 11
run-time and developer support, 7
Solaris vs. CDE environment, 2

$quote directive, 72

rubber buttons, 59

optional integration, 44
source code location, CDE examples, 51
Stub, 40

T
tasks
  porting to CDE, 3
  porting to Motif, 2
tear-off menus, 29
Terminal
  DEC VT220-like, 15, 38
  DtTerm widget, 15
Terminal widget
demo programs, 15
  library and header files, 15
Text Editor
demo programs, 17
  DtEditor widget, 16, 38
  library and header files, 16
  when to use widget, 16
text field and arrow button widget
    (DtSpinBox), 13
text field and list box widget
    (DtComboBox), 13
text selection, secondary, 29
toolkits, implementation differences, 29
  ToolTalk Messaging Service, 20
    message sets, 21
  ttsnoop, 21
  tttrace, 21

U
UIL, 10, 36, 50
UIL compiler, 7, 10
UILDef.h header file, 10

W
widget
  CDE control, 12 to 15
  DtTerm, 15
  Motif 1.2, 14
  Motif 2.0, 14
  XmForm, 11
  XmList, 11
window controls, 29
Workspace Manager, 20

X
X resources, 35
X Server, 19
XGL, 19
XIL, 19
Xlib, 31
Xm library, 39
XmArrowButton, 38
XmComboBox, 14
XmCommand, 38
XmDrawnButton, 39
XmForm widget, 11
XmFrame, 39
XmLabelGadget, 39
XmList convenience functions, 11
XmMainWindow, 39
XmPanedWindow, 39
XmSelectionBox, 39
XmSpinBox, 14
XmString, 71
Xt intrinsics, 53
Xt library, 39
XtSetLanguageProc(), 71
XView, 3, 20, 28, 32, 53
packages, 33, 34
XView libraries
differences from Motif, 34
external files, 35
objects similar to Motif, 33
terminology, 31